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2019:
the year indie dies?

T

his is not an indiepocalypse column. We’ve
had plenty of those, and they’ve all been
wrong. This is, however, a cautionary piece.
I’d argue that 2019 will be remembered as
the year ‘indie’ died. Why isn’t this an indiepocalypse?
Well, let’s dig into some terms.
Originally, ‘indie’ just meant independent, or made
without the aid of a publisher. We’re so far past that
point that indies have themselves become publishers.
Chucklefish and Stardew Valley come to mind here.
So when I say 2019 is the year indie died, I mean in
the original sense. The death of self-funding, and the
return to publishers as default.
The indie bubble was created in large part by Steam
curation. It artificially forced a small number of tiny
games in front of, effectively, the entirety of PC gaming.
That created the initial wave of indie hits, and we’ve
been coasting along on Steam’s good graces ever since.
That was always going to end, and it did, with 2018’s
discovery algorithm shift. To be fair, Steam’s hand
was forced a bit by the flood of games (most of them
good), but we’re far enough past the algorithm change
to know that indies impacted by it aren’t rebounding,
which sets the timeline.
Most studios try to set aside six months of buffer
money. Those six months start burning in January,
when the payout for Steam Christmas is much lower
than expected. Those who can move into contracting
will, but most will simply taper into non-existence by
the autumn. A handful will attempt Kickstarters, but
most of those will probably fail. (This isn’t a knock on
Kickstarters or indies, but an observation of which tier
of indie all this hits hardest.)
Many will shift back to pitching games to publishers.
Indies without six months of buffer will be hit hardest.
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This was their first or second major release, and they
were counting on Steam Christmas money that didn’t
come. Those same studios are too young to pull off
Patreons or Kickstarters due to a lack of community,
and had insufficient forewarning to build one.
They are, in part, who I’m writing this to. You just saw
your sales report, and it punched you in the gut. Part of
you is going, “We’ll buckle down and hit Steam again.”
Don’t. Stop, and recognise the game has changed.
We’re no longer in a market where selling a good game
on Steam is likely to work. You need fallback plans. You
need to work on establishing the core community that
will buy your games no matter what, or find someone
to hire you to work on their game. Next-gen consoles
are also about to emerge, and you could pitch your
next game directly to them.
I’m also writing this for gamers. We’re seeing a market
shift – and boy, will this one favour you. Player eyeballs
have been gobbled up by huge stores, and well-funded
newcomers – Game Pass, Twitch, Discord – are fighting
for those eyeballs by offering free games. The money
won’t last forever, but while it does, you’ll be drowning
in games. It’s the same force washing the lower end out,
and pushing everyone else to strike deals (possibly with
Game Pass or Discord) to survive the flood.
We game devs need to position ourselves so we can
survive until the market recovers – which it will. After
that, we’ll see next-gen consoles begin to pull everyone
back up. Consoles tend to remember indies are handy
when struggling for exclusives, and that’s often enough
to power a rebirth. So we’ll see.
Until then? It’s a good time to climb into a bunker.
Take a bunch of great games in there with you –
goodness knows there’s enough of them floating
around for the taking lately.

wfmag.cc

\ 03

Contents

Contents

6
Attract mode
06. S
 omeday You’ll Return

18. Plasticine not pixels

10. Hoa

24. Interactive: Notemon

12. C
 all of Saregnar

44. Dream on

16. Incoming

50. T
 okuro Fujiwara

The tiny dev team making an
ambitious horror game

Sumptuous, Studio Ghibli-inspired
animation from Singapore

Slovenia’s homage to nineties fantasy
role-playing games

44
04 / wfmag.cc

Interface

Soviet robots, low-level crime, and
cyberpunk detectives

Devs making games with bits of wire,
clay, and wool
The monster-catching RPG steeped
in New Zealand’s culture

Exploring the Dreamcast’s vibrant
indie dev scene
The mind behind Ghouls ‘n Ghosts
and Resident Evil profiled

Contents

WELCOME
Games may be made up from
clever, scientific things like
polygons and thousands of
lines of code, but they’re also
worryingly good at zoning in
on our primal fear centres.
Long before the survival horror
genre was a thing, fear was
a vital part of game design.
Look again at Space Invaders,
and the aliens’ slow, zombielike advance toward the
hopelessly outnumbered player;
in its own, rudimentary way,
it’s pretty nightmarish.

18

59
Toolbox

50
Rated

28. Design Principles

56. Resident Evil 2

30. CityCraft

58. Dusk

32. Source Code

59. A Fisherman’s Tale

34. Finalising your Unity FPS

60. Pikuniku

How economy and theatre make
better games
Why a game city is only as good as
its surroundings
Recreate the jumping physics from
Super Mario Bros.

Add menus, special effects, and more
in the final part of our guide

A horror classic is revived in
spectacular style
Nineties-style shooting worthy
of the mighty Quake
Puts your virtual reality headset
to mind-bending use

As Lottie Bevan points
out in her column on page
26, technology is allowing
developers to create ever more
vivid scenes of terror and gore
– Konami’s intense Resident
Evil 2 remake is certainly a
testament to that. But at the
same time, it’s often the games
that generate suspense without
gore or violence that disturb
us the most. In Alien Isolation,
it was the build-up to the
appearance of the title monster
(or those pesky androids) that
sticks in my mind. Similarly, the
eerie stillness of Everybody’s
Gone to the Rapture was oddly
flesh-crawling, even though
there wasn’t a monster in sight.
It’s why we’re so intrigued by
Someday You’ll Return: it aims
to create a psychological horror
with no weapons or combat.
Of course, we don’t know if the
team behind it will achieve their
goal of making a great scary
game without jump scares, but
as Gone Home proved, it’s often
the quieter, more low-key games
that provide the most suspense.
Ryan Lambie
Editor

Puzzling, with humour and
charm to spare
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Exploring the
silent hills
Czech studio CBE Software’s Jan Kavan and
Lukáš Medek tell us about Someday You’ll Return,
and a horror that will linger

T
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You’re very clear about Someday
You’ll Return’s influences. What’s the
thinking behind this heart-on-yoursleeve approach?
Jan: The thing is, our game is a bit
different. When the trailer comes out,
there is immediately this ‘walking simulator’
connotation – people say it will be another
of that genre. So one of the reasons we
list these titles is, not only because we like
them and are influenced by them, but to
show we’re not going to be a pure walking
simulator, because we have influences
from games that are definitely not
walking simulators!
It’s very hard to come out with a new
IP and not provide a helping hand to the
press, for example, in this gaming sphere.
So it helps them categorise the game
more, though the game does have some
ideas which are very new in gaming per se.



he story behind Someday
You’ll Return’s path to
becoming a finished game
could be framed as the
triumph of the plucky
underdog; a success snatched from
the jaws of defeat. A few years ago, the
game’s developer CBE Software released
J.U.L.I.A.: Among the Stars in partnership
with UK publisher Lace Mamba. To say the
relationship didn’t work out would be an
understatement – royalties were said to be
unpaid, profits disappeared, Lace Mamba
ended up closing, and CBE was left with a
black eye.
Since reclaiming J.U.L.I.A. and rereleasing an updated version, CBE has
dragged itself back up from the brink, and
focused all its efforts on the first-person
psychological horror of Someday You’ll
Return. The game centres on a father’s
missing daughter, his search taking him
to locales modelled on real places in the
Moravian region of modern Czechia and
Slovakia. As well as looking gorgeous,
CBE’s two-man team promises the game’s
horror is something that will elevate the
experience, helping it to live on in the
minds of players for years to come.
Surviving the horror of a rogue publisher
has to leave scars. Someday You’ll Return
could prove itself to be CBE’s absolution; a
triumph in an industry that once seemed
hostile. We spoke with Jan Kavan and
Lukáš Medek about Someday You’ll Return’s
road to release.

No jump scares, but
Someday is still spooky.

Do you think it could harm the game at
all, with people expecting a Silent Hill 2 or
Resident Evil 7?
Jan: If people are expecting something like
Silent Hill 2 they will find some stuff that
will make them happy. But it’s not like this
is a clone of Silent Hill 2 – it’s more how we
approach the symbolism, the meanings in
the game and how we tell the story. There
are some things that people who really
liked Silent Hill 2 – like me – will enjoy. Of
course our game is different, it’s not trying
to be a copy of anything else. It could be
interpreted that way, but that’s always
the risk!
You’ve opted for real-world locations for
the game – why is that? What significance
do they have to you, and how is that
translated to the game?
Lukáš: We’re putting into the game
the places we grew up in – it’s a great
inspiration for the game because you
can actually go there. These places have

Attract Mode
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“It’s not only about
a missing child, or
somebody running away
– every father is guilty of
things in the game”
core of the story we’re trying to implement
as much as we can from local folklore and
myths from these places. So the Bohemian
mood from the old legends should
be there.
Jan: But still it’s possible to digest the story
even without being interested in Slavic
folklore. It’s really more to bring this local
vibe into it all, but you’re really looking
for your daughter and it’s a very universal
feeling, losing your child. The same
everywhere as in the Czech Republic.

a unique feeling for us because of the
memories and experiences we had there,
so it immediately brings new ideas for the
story, for example. Also we can go there
and get a whole picture of the place, its
mood and atmosphere, so we can recreate
it better in the game. That’s not to say
these regions are placed exactly like they
are in real life – they’re more an emotional
link. They look different, but the mood
is there, and it comes from our actual
memories of the places.
How much of a ‘Czech’ game is this? Will
your fellow Czechs feel an intimate bond
with the game, for example?
Lukáš: We have strong feedback from
locals who’ve seen the game, saying ‘Oh
I know it! It’s like home!’ And we think it
could be great for foreigners, too – the
Slavic environment is really popular from,
say, the Witcher games. So we hope it
could be something fresh for that... In the

How much does fatherhood inspire
Someday You’ll Return’s story and design –
is it based on real fears?
Jan: I have four kids, so it’s something
that taps a lot into my deep fears. It’s not
only about a missing child, or somebody
who’s running away from you – it’s more
about… everybody, every father is guilty
of the things which are in the game. It’s
something I want to present in the story
– it’s not only about the worst stuff that
happens, there’s all this mundane stuff
which everybody does to a certain extent.
The real horrors aren’t just the strange,
horrible things, but also the everyday,
mundane things which we sometimes
don’t even acknowledge that we’re doing.
Designing a game without combat is,
oddly, the exception to the rule. What
specific challenges are there, when you’re
making a game that does have a threat
to the player who can’t fight back?
Jan: One of the things that’s nice about
that – when you’re fighting something, you
always have the feeling there’s a chance to
beat it. You have a gun, and if you’re skilful
you can shoot it in the head or something.
But if you don’t have this option, then
the fear is much stronger because you
still want to survive, but you don’t have
a feeling where you can turn a former
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camping instructor into a marine who can
go in with a gun and shoot a thousand
monsters – which is total nonsense,
because he doesn’t have a skill-set for that.
The other thing that’s a big challenge for
us is that you have to design many more
elements when there’s no combat – when
you have combat, you can basically plug
in a lot of enemy waves, you can plug
in arenas where you just run around in
cover and shoot, the default scheme of
things these days. But if you don’t have
this, you have to come in with different
ideas. We have a strong adventure game
background, so we bring in stuff from
there. There’s crafting – we have a huge
interactive system for that, where you
have to actually build things – and we also
have other elements like stealth, which
help overcome this. But it is much harder,
because when you can’t just copy-paste a
load of enemy waves you have to come up
with original ways in which to overcome
this situation. In this aspect it’s much more
difficult, without combat.

“We’ll never take a game
we invested millions into
and give it to a company
which may or may not
care about it”



Crafting makes this more
than just a walking sim.



Interview

The landscape really is
quite beautiful.

How did you decide on your funding
approach this time around? It’s been a
rollercoaster of publishers and Indiegogo
experiments over the years – how do you
know this is the right way to do it?
Jan: We have four main sources of income
– our last game, J.U.L.I.A.: Among the Stars,
was pretty successful, so the whole income
from this game we poured into Someday.
We were also very happy to be awarded
a media grant by the European Union for
development. There was also the Epic
Games Development Grant for Unreal
Engine games. And at this point there’s
also quite a big personal investment in
this project by me, so that’s another chunk
of money we’re putting on the table. At
this point we’re confident we can finish

development and release that game with
this funding.
I assume your experience with Lace
Mamba and J.U.L.I.A.: Among the Stars
factored into your decisions?
Jan: We’ve been in the industry a lot of
years; we started CBE in about 2006, and
we’ve been in the industry since 2002.
And through all these years the story has
just repeated, so we’re confident that we
know. If we’re going through the publisher
route, we’re looking at local markets,
but we’ll never take a game we invested
many millions into and just give it to some
company which may or may not care about
it. So that’s the problem we had.
Visibility is going to be a challenge – how
do you see the market for Someday
You’ll Return?
Jan: We are enthusiastic – the reception
of our trailer was pretty huge, and we
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No, the hammer cannot
be used as a weapon.
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Can you send a text to get
help? Probably not, no.

UNREAL-LY

have the feeling there might be people
interested in this game. We travelled to
many of the conventions, we got some
awards, but also the people there who
played the game were enthusiastic. So
we feel somehow we can tap into a much
bigger playerbase than with J.U.L.I.A. – even
though it was greatly received, with a great
core of players and really positive reviews
on Steam, still it’s a niche if we compare it
to Someday You’ll Return. We think this will
be much bigger.
What’s your current team set-up like?
What’s the pipeline or workflow like on
any given day?
Jan: Really we don’t work in separate roles
like you would in a corporate situation; we
are much tighter, discussing any individual
idea so we are clear from the beginning
how it will work, if it will work, if it’s not
just a dream. Sometimes you have a
great idea, but then when you figure out
everything you need to make the idea, you
have to carefully calculate if it’s actually
implementable for a reasonable amount
of money! We have a Trello system where
we have boards for our features and a
task list; whenever we’re done with a task
we sit down and discuss stuff. We do a lot
of iterations, so we can sit and look at the
game, discuss how it plays, what works,
what can be done, where it can be better,
where it can be more streamlined, where it
can be clearer for players. It all feeds back
to design, so there might be changes to
the lighting system, there can be changes

in the visibility on levels, but there can
also be many systematic changes in the
code… so it’s just basically like one huge
circle going round and round to make sure
everything works how we want.
This is the first time you’ve brought
something to console – what’s that
been like?
Jan: We’re afraid! But I’ve heard rumours
the PS5 is coming, so if that’s coming it
can just be a straight port [laughs]. But at
this point we’re focusing on the PC build
– when you have a PC build on Steam,
for example, you can roll out a patch
in a minute. Our goal at this point is to
create the most bugless version possible,
so when we port it to console we might
fight with some console-specific issues,
but not with the game itself. Patches on
console need to be approved, there’s a
lot of workflow in that, so at this point
we’re working on finalising the Windows
PC build.

Someday You’ll Return has been made using
Unreal Engine – something Jan is convinced
was almost inevitable: “I don’t think we have
an alternative,” he says. “Unreal Engine is so
far ahead of other engines at this point. You
can meet a lot of challenges working with any
engine, but with UE we are so comfortable
now. We might have to constantly struggle
in another engine, but here we can create
something which is really unique, so I don’t
think we would be willing to change. This
engine is really powerful, and has great
support – not just for the engine, but for the
community, too. It was the right choice for us.”

Finally, I’m terrible with horror. Sell it
to me – what am I going to get from
Someday You’ll Return?
Jan: You’re not going to get jump scares
or some kind of gore-fest. You’ll get a
horror that you will think about for a
long time. While there are some very
disturbing things in the game, it’s not
based around them – it’s more like if you
read a great book then you’ll dwell on it
for many months. That’s what we’re trying
to recreate here, so it doesn’t just end by
killing a boss monster and calling it a day
– it will really ask a lot of questions, and it’ll
be up to you to answer them. So it’s a bit
different. I’d be lying if I said it was just a
walk in the forest, though – it gets pretty
disturbing at times, but it doesn’t focus
entirely on these elements.
				
Someday You’ll Return releases on PC in
2019; console versions will follow.
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Hoa’s lush world is partly taken from its
creators’ environment, with the devs
taking reference photos at Singapore’s
parks and botanical gardens.

Turning a new leaf
Hailing from Singapore, hand-drawn platformer
Hoa is already a thing of beauty
GENRE
Platformer
FORMAT
PC
DEVELOPER
Son Tung
PUBLISHER
Son Tung
RELEASE
TBC 2020



artists like Aaron Blaise and Goro Fujita –
their amazing work taught me a lot about the
art of animation.”
As well as traditional painting and animation
techniques, Hoa also weaves 3D imagery
generated in Maya to create a sense of
movement and depth.
“We mainly use 3D for characters, creatures
and elements that require a lot of animation,”
Son Tung says. “Rather than animating in a
traditional way, working in 3D saves us a lot
of time to create smooth animation. For the
illusion of depth, there are two things we need
to pay attention to. The first one is to arrange
the elements in Z-axis to create convincing
parallax effect, and the second one is to
apply atmospheric perspective when painting
the background.”
While Hoa is still a nascent project, its
creators hope to have a playable demo to show
off by the middle of 2019; if the feedback’s
positive, then the aim is to have the finished
game out by the following year. Rather than a
free-roaming Metroidvania, Hoa will go for a
more linear, story-driven design, Son Tung says.
And while the imagery shown here is bathed in
sunlight, he adds that Hoa’s narrative will also
visit some darker places.
“There will be a lot of puzzles in the game,”
Son Tung says, “but probably no combat. Our
vision from the start is for Hoa to be a game
with minimum violence. The game starts on a
bright note, but as players venture on, they will
discover bleak corners of the game’s world and
the stories behind it.”

Info

I

t may still be in early development,
but Hoa has one of those game worlds
that make us want to crawl into the
screen, breathe in the fresh air and
maybe fall asleep under a leaf. A
side-scrolling platformer created by two former
art students in Singapore, Hoa was conceived
as a soothing, non-violent experience right
from the beginning.
“When I first came up with the story of Hoa
about a year ago, I had no idea how the game
would look,” co-developer Son Tung tells us.
“The only thing I knew at the time is that I
wanted it to be so beautiful that you would
want to play it just to be in it. I’ve always been
attracted to beautiful platform games, so
whenever I see an interesting visual, whether it’s
a photo, a painting or a movie scene, the first
thing that comes to my mind is how can I create
a side-scroller with this kind of look.”
Hoa’s luminous hand-painted style most
obviously resembles the output of Japanese
animation house, Studio Ghibli; the tiny heroine,
who jumps from leaf to leaf in a verdant forest,
recalls the firm’s 2010 film, Arrietty. But while
Son Tung readily acknowledges the influence
of Studio Ghibli and its co-founder Hayao
Miyazaki on Hoa, the game also draws its
inspiration from a wealth of other sources.
“I had the privilege to attend classes of
animation legends Hans Bacher and Ishu
Patel during my time at ADM,” Son Tung
says, referring to Singapore’s School of Art,
Design and Media. “Their teaching had a lot
of impacts on my works. I also closely follow

“ There will be conflicts, but
they will not be solved with
Hoa launching fireballs
towards the enemy,”
Son Tung says.
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Answering the call

 averns are areas where
T
players will pick up information
to complete questlines.

How Call of Saregnar plans to revive nineties-style RPG
classics like Daggerfall and Betrayal at Krondor

Info

GENRE
RPG
FORMAT
PC
DEVELOPER
Rhuantavan
PUBLISHER
Rhuantavan
RELEASE
TBA



 ozetič chose to use real
M
actors in order to give players
a real person to relate to.

L

ooking at screenshots of Call of
Saregnar, you might be forgiven
for thinking it’s a long-lost RPG
from the 1990s. The characters
are photographed actors, the
textures are grainy, and the environments are
made up of flat 2D objects. In reality, Call of
Saregnar’s a brand-new game from Slovenian
designer, Damjan Mozetič. Envisioned as a
return to the western RPGs of old, it draws from
titles like Might & Magic VI and The Elder Scrolls II.
The biggest inspiration, though, comes from
Mozetič’s first love: 1993’s Betrayal at Krondor.
For Mozetič, Betrayal at Krondor was a
formative experience. At age 14, he managed
to get his hands on a pirated copy of the game –
a practice not uncommon at the time, given the
state of the Slovenian market after the breakup of Yugoslavia in 1991. The experience was
like nothing he’d ever played before, and led to
several late nights spent at a computer with a
dictionary at hand to compensate for his basic
understanding of English.
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 hanks to a custom shader, Call of
T
Saregnar’s trees now have shadows.

“I’ve wanted to make a game like Betrayal
at Krondor since forever, because the sequel
was never released,” says Mozetič, referring to
Krondor’s cancelled follow-up, Thief of Dreams.
“I mean, there was Return to Krondor, but that
was not the game that was originally supposed
to be released.”

SPIRITUAL SUCCESSOR

“Krondor had it all,” Mozetič enthuses. “It had
great characters. It had a great world, which was
Midkemia from [the series’ author] Raymond
E. Feist’s books. So it had this really nice
background to put a story in, and Neal Hallford,
the author of the story and the characters, did a
great job.”
Call of Saregnar is in many ways a spiritual
successor to the original Krondor. Not only do
both feature real actors in the role of nonplayable characters, but the two games are also
divided into chapters and include an open world
you can explore almost from the beginning,
populated with new missions depending on the
chapter. They also feature turn-based combat
and strategy elements, with the player able to
launch sneak attacks on enemies or fall into
ambushes in either game.
Making a game like this isn’t easy: financing
and workflow aside, Saregnar uses techniques
that aren’t common in contemporary game
development. This often means educational
resources are hard to come by, with his game’s
aesthetic being particularly difficult to get right.
“There’s no info online whatsoever,” Mozetič
says of his approach to Saregnar’s graphics.

Attract Mode
Early Access



 layers can set up a cold camp in dangerous
P
territories to avoid attracting attention from bandits.

“I had to figure out by myself how to do it.
For example, the trees were interesting. I
eventually got Charles Thomas, a freelance
shader programmer from France, to help me
with a shader. I wanted those trees to have a
shadow on the ground, so he helped me with
that. Because, as the sun moves around, the
shadows [need to move]. The trees are still
billboards, they’re 2D, but there’s a technique we
use to project the same shape of the tree on the
ground. It ended up looking really nice.”

 There are a number of towns to

explore in the game, all complete
with NPCs, including the villages
of Romar and Ergendon.

Collaboration has been key to the
development of Call of Saregnar. Though
Mozetič wants to keep his team small in order
to avoid moving away from his central vision
– a move that has resulted in a somewhat
protracted development – everyone who’s
come on board so far is equally passionate
about the game. Composer Tony Manfredonia,
for instance, has produced several medievalA STROKE OF LUCK
style tracks inspired by Krondor’s score and
There’s also a logistical problem of finding
other similar games from the era, while sound
enough actors to populate the world’s locations.
designer Benjamin Reichstein has worked
When you think of RPGs, you tend to think of
hard to nail the warm, rough, retro sound that
towns and villages filled with roaming NPCs and
fans expect.
quest-givers. For Mozetič, this presented the
If you’re wondering when we will see Call of
issue of finding and casting a large group of
Saregnar on digital storefronts, it’s not anytime
performers to fill the roles.
soon, according to Mozetič. The game is still
Luckily, though, he soon crossed paths with
relatively early in its development, with a
the Principesca Contea di Gorizia, an Italian
Kickstarter and demo
medieval re-enactment
being the next target
group (of which he’s
“I’ve wanted to make
now a member) which
the team are working
a game like Betrayal at
comprised several fans
towards. After that,
Krondor since forever”
of classic RPGs. They
Mozetič hopes he’ll be
were more than willing to
able to quit his nine-tohelp out, and even provided some of their own
five job and work full-time on the game, as well
costumes for the roles.
as bring on some new faces in order to speed
“The characters are the biggest challenge,
up development.
because I had to do things that weren’t
With Call of Saregnar, Mozetič is hoping to
traditional game development,” says Mozetič.
hark back to a simpler time for western role“It’s not development, it’s not programming.
playing games, where the focus was more
It’s getting people together and organising the
on evoking a sense of atmosphere through
photo shoots and hoping that everything will
adventuring, and telling a story rather than
work right – so it is a big relief when it does. I
providing complicated combat systems or
currently have about 20 characters, with some
increasingly detailed environments.
of the same actors wearing different clothes, but
“There are many action games around, but
since I’m doing low-resolution, I can get away
RPG games like mine, there are basically none,”
with having the same face repeating in other
says Mozetič. “I really want to make a game
scenes. I also photographed the characters from
that differs from [other role-playing games]. I’m
different directions, so I can show them from
trying to tap into that niche market, which I think
the front or from the side or from the back.”
people don’t even know they’re missing.”

A TIMELINE OF
INFLUENCES
1993: Betrayal at Krondor
One of the first truly
open-world RPGs,
Krondor tells a
tale of magic and
political intrigue.
1994: Realms of Arkania:
Star Trail
The second entry
in The Northland
Trilogy, a series of
games based on
the German RPG,
The Dark Eye.
1996: The Elder Scrolls II:
Daggerfall
The second Elder
Scrolls game boasts
a map roughly half
the size of the UK. It
follows the Hero of
Daggerfall and his
attempt to solve the
mystery surrounding
the death of
King Lysandus.
1998: Might and Magic VI
A party of four
adventurers rise
to defeat the
invading Kreegans.
This superior
sequel included
deep character
customisation
systems and plenty of
side quests to uncover.
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02. S
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01. E
 pic flex
Announced in December, the Epic games
store has since launched and is… well,
another online store controlled by a
developer/publisher. Needing to upset
Steam’s hegemony over the PC digital
sales market requires aggression – first
the 12% cut taken by Epic (Valve takes
30% for Steam), and now something to
directly impact consumers.
Epic has bagged THQ Nordic’s Metro
Exodus as a timed exclusive on the store,
meaning it will not be available on Steam
– even though pre-orders (which will
be honoured) have been open a while.
Valve’s reaction to this move has been to
label it ‘unfair’, while THQ Nordic has put
the decision solely at the feet of sister
company, Koch Media. The waters are
getting a bit choppy, it seems.

Sad news towards the end of last year
saw Starbreeze filing for reconstruction
(basically bankruptcy protection) and
its CEO Bo Andersson stepping down.
A report from Eurogamer, though, shed
some light on the last days of Andersson
– and it turns out he blamed the studio’s
developers for its lack of success.
In his final email to staff, the outgoing
CEO wrote: “Personally though I lost all
my money, my family in divorce and my
kids custody through the toil over the
last 2–3 years, working 100-hour weeks
for Starbreeze and keeping you devs
paid and in the game. With less and less
developers willing to put in the extra care
in a product, it clearly limits the possible
result of enough quality in time.
“This is a new era and I did not leave
the old one and adapt in time – my fault.
It’s ok – it’s new times.”

Anthem demo suffers connection
issues, unsurprisingly

14 / wfmag.cc

03

03. L
 eather fallout
Bethesda appears set on testing
consumers with as much unique
merchandise as it can, with the
announcement of a Fallout leather jacket.
Following on from the dubious ‘canvas’
(initially polyester) bags for Fallout 76’s
collector’s edition and its bottles of
(plastic fascia-ed) Nuka Rum for the same
game, we’re hardly surprised there was
a reaction at the jacket’s announcement.
That is to say: people aren’t impressed,
and people are very wary of Bethesda’s
merchandise these days.
It costs £210, by the way.

Apple plans ‘Netflix for
games’; nobody surprised

Attract Mode
News

04

06

06. V
 alve time is
05

04. P
 ress A/F

to Jason

Quantic Dream’s exclusive affair with
Sony is over, after the French studio
received an undisclosed minority
investment from Chinese firm, NetEase.
With the money to hand, the team is
to release future games on multiple
formats, after having been PlayStationexclusive since 2010’s Heavy Rain.
CEO David Cage said: “Having NetEase
by our side as a strategic partner will
allow us to expand our creative vision
and develop the company to its fullest
potential,” which is much less pretentious
than what we’re used to.
This isn’t NetEase’s first throw of the
dice, with the company investing £76m
into Bungie towards the tail end of 2018.

Rami Ismail announces gamedev.
world, running June 21–23

05. M
 r Fighterman
Pop quiz: who would be your ideal
addition to the roster of a Mortal Kombat
game? If you said ‘Shaggy from ScoobyDoo, obviously’ then congratulations
– you’re aware of daft little jokes getting
out of hand!
Yes, The Internet has decided it
wants Shaggy in Mortal Kombat 11,
and a petition has seen hundreds of
thousands of signatures demanding the
addition of the cowardly hippy to a game
about ripping off arms and beating an
opponent to death with the wet end.
Will it happen? Series co-creator Ed
Boon is aware of the petition, so we’re
allowing ourselves to dream a bit here.

‘really nice’

Valve Time – the somewhat pejorative
term thrown at the studio when speaking
of its glacial pace towards… well, anything
– isn’t a bad thing, according to Jane Ng,
artist at Campo Santo (brought under
Valve’s wing in 2018).
“In reality,” she wrote on Twitter, “it’s
really nice to walk around a mostly
empty office at 5:30pm because I know
people get to be parents to their kids,
and/or just be living their lives outside of
their jobs.
“How this should just be the norm
for everyone in a wealthy country is a
separate conversation. For now, I’m
glad this is the culture Valve folks have
collectively decided is the right course.”
Sort of puts a different spin on things
really, doesn’t it?

Original Wii Shop Channel
closes for good; tears shed

wfmag.cc
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Atomic Heart
Imagine an alternate version of the Cold
War-era Soviet Union, where futuristic things
like robots and holograms nestle alongside
cathode ray televisions and kitsch wallpaper.
That’s the setting for Atomic Heart, the upcoming
shooter from Russian developer Mundfish. The
game’s already received plenty of attention
thanks to the fidelity of its graphics, but what
we’re most excited about is how imaginative
its environments look. Its abandoned science
facility is filled with exotic-looking robots and
surreal anomalies – one recent trailer shows
a brood of chickens suspended in some sort
of jelly, marauding water tentacles, and crazed
mannequins with unnerving kung-fu skills.
Atomic Heart’s creators cite Stanislaw Lem,
the Strugatsky Brothers and Black Mirror as
influences, so beyond all the technical brilliance
on display, we’re hoping to find a compelling
piece of science fiction, too.

Kine
Guide a trio of spindly robots around blocky
obstacle courses in this forthcoming 3D puzzler,
currently being developed by Gwen Frey. Each
robot can be manipulated so that it can span
chasms or flip over walls; the aim is to collect
pages of sheet music and avoid falling to
your doom.
Release date: TBC

Release date: TBC 2019

Tales of the Neon Sea
It’s Blade Runner, but rendered in a captivating
early-nineties pixel style. Tales of the Neon Sea
is a cyberpunk adventure about a crumpled
detective navigating a dystopian cityscape of
cyborgs, seedy bars, and general malaise. We
don’t yet know what mysteries we’ll be asked to
solve, but developer Palm Pioneer’s murky world
looks well worth a careful investigation.
Release date: TBC 2019

16 / wfmag.cc
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Family Man
A blocky world straight out of Minecraft gets a jolt of
Coen brothers-esque weariness. You play an increasingly
harried father who faces the choice of working a regular
job that barely pays the bills or descending into a life of
crime. Forget the high-octane gratification of Grand Theft
Auto; Family Man faces you with mundane activities like
flipping burgers and boat theft. And, at the end of it all, a
gnawing sense of sadness and guilt. It sounds thoroughly
miserable, and we can’t wait to try it.
Release date: TBC 2019

The Bradwell Conspiracy
If games have taught us nothing
else, it’s that working for mysterious
tech companies is a terrible idea.
In first-person adventure game The
Bradwell Conspiracy, you wake up
in a seemingly deserted museum
following an unspecified disaster.

Armed only with a pair of augmented
reality glasses, your task is to find
out what happened, and what your
employer, Bradwell Electronics, has
to do with it all. Austin Wintory is
composing the music, so we already
know this one will sound spectacular.

Release date: July 2019

Road to Guangdong
We’re seeing an increasing number of indie developers
take a more measured approach to the driving genre of
late, and Road to Guangdong is an upcoming example.
Like Jalopy (that earlier game from publisher Excalibur),
this is a kind of road-trip drama that’s as much about the
relationship between its two lead characters, a young
woman and her aunt, as it is about cruising along an
open road.
Release date: May 2019

Wira & Taksa
Hailing from Peru, here’s a jolly-looking platform
puzzler that combines gravity-flipping action
(akin to Terry Kavanagh’s cult hit, VVVVV) with a
mechanic that allows you to switch between the
two central characters. Taksa is fast and nimble,
while Wira is slow and cumbersome, but wields
a gigantic hammer that he can use to smash
enemies. No prizes for originality, then, but the
puzzles and presentation make Wira & Taksa
worth your consideration.
Release date: July 2019

wfmag.cc
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NOT PIXELS
Real-world materials and video games
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FRANCESCA HARRALL
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With digital artwork so easy to create, why do some devs
favour using physical materials like paper, plasticine and
wood in their games? Wireframe finds out

A

fingerprint, a fresh crease in a piece of card, a
smudge of dirt – while errors in digital game design
can be erased and fixed, physical imperfections
are encouraged in games made from real-world
materials. In fact, that’s the point of choosing
tangible items to craft with; designers want the flaws and the
irregular feel of a piece of fabric or a rusty nail. Without them,
their games lack something physical that often can’t be re-created
in a 3D modelling package.

For decades, we’ve seen alternative art styles from studios that
have harnessed the irregular feel of organic materials; they’ve
reshaped and formed them into imaginative environments or
new characters. Recent and upcoming examples include the
otherworldly adventure game, Sluggish Morss: Pattern Circus,
beautiful paper adventure, Lumino City, and the nautical Harold
Halibut, due for release later this year. They’re proof that the
interest in games diverting from more traditional digital art
styles is far from dying out.
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 .5 tonnes of clay were used in
3
the making of The Neverhood.

WHERE IT BEGAN

Ready-made
designer
“Sometimes we don’t even
have requirements”, says
Luke Whittaker, co-founder of
State of Play Games, when I
asked him about the process
of hiring people to work on
physical medium games.
“[One future employee] turned
up with a miniature model of
himself in a presentation box,
marketing himself as a readymade designer in waiting.
We weren’t looking to employ
anyone, but took him on based
on that. He was soon making
models, designing pinball
tables in INKS, and puzzles in
KAMI 2, so his role changed on
the job.”

There’s something about the organic feel of
real-life fabrics, clays, and metals that some
developers actively seek out. The games made
from these materials can be puzzles, fighting
games, platformers, RPGs, or something else
altogether. They can be creepy, dreamlike,
wholesome, or all these things at once.
Handmade games don’t even have to include
3D models or sets; they can begin as an etch
on a piece of parchment or a blot of ink, and
transform into something breathtakingly unique:
Nomada Studio’s Gris is one recent example.
Using physical materials in game design
isn’t an easy route to take; there are all kinds
of practicalities to consider when you’re
manipulating wires or bending plastic. There’s
the cost of labour and supplies. Materials might
not look or behave the way you expect them to:
they can break, burn, and collapse, and there’s
no ‘undo’ key to rescue them. You also have
to consider how to actually make things; how
to translate the physical into the digital. Often,
this involves painstaking efforts to photograph,
digitise, and animate your once-blank pieces of
paper and shapeless lumps of clay. Then there

are the pressures of deadlines to consider. All
of which raises an obvious question: why do
developers even bother?
Let’s start our journey back in the 1990s,
with a generation of games that began to use
different materials to bring their characters to
life. Among these were the ClayFighter titles, the
first released in 1993, which used stop-motion
animation and dollops of plasticine to bring
their combatants to life.
By the 16-bit era, home computers and
consoles were advanced enough to display
digitised frames of stop-motion animation;
you couldn’t necessarily see every thumb print
or scratch due to the systems’ low-resolution,
but games like ClayFighter and Claymates,
both created by developer Visual Concepts
and publisher Interplay, certainly had a more
organic feel than most other games available
at the time.
One of the most ambitious claymation
games of the era was arguably The Neverhood,
by The Neverhood, Inc – a studio founded
by Earthworm Jim creator, Doug TenNapel.
Released in 1996, it was a point-and-click
adventure created by using over three tonnes
of real, actual, physical clay. At the time, 3D
polygon-based games, while relatively new, were
very much in vogue, so The Neverhood – in all its
quirky, uneven glory – was definitely an outlier.
Since The Neverhood opened those clay
floodgates, there has been a steady flow of
similarly creative games, made with a wide range
of materials and styles. The Czech Republic’s
Amanita Design is just one independent studio
with a knack for creating handmade games,
each with its own art style. From hand-drawn
adventures such as Questionaut (a short
web game made for the BBC in 2008) and
the gorgeous, award-winning illustrations of
Machinarium, to the surreal Samorost series,
Amanita’s games have a style and atmosphere
you can safely describe as ‘completely unique’.

CRAFTING THE RIGHT TEAM

 Erik Zaring working at

the IKEA desktop, where
The Dream Machine was
created in its entirety.
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Building a harmonious dev team is no easy
feat, especially when you have your sights set
on designing your entire game from real-life
materials. All of the usual technical aspects of
game design still have to be worked around,
like coding it to work the way you want it to or
writing a believable story. But additional factors
come into play – you have to consider building
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 andmade design doesn’t have
H
to just be clay or paper;
Machinarium involves some
pretty complex illustrations.

 pace gnomes, magic flutes, and
S
alien worlds; the Samorost series is
as beautifully crafted as it is bizarre.

but being flexible as a team, and figuring out
what dynamic works best.

TEAMING UP

Consider, though: what about when your
aesthetic vision is progressing nicely, but the
game mechanics or story are lacking something
– do you scrap the idea? Not necessarily. It may
be that it’s time to bring in fresh minds or work
with other developers to kick the game back
into gear. Did you know that Kirby’s Epic Yarn,
for example, was never originally a Kirby game?
Beginning its life as Fluff’s Epic Yarn (who later
became Prince Fluff, a secondary character),
Good-Feel set about deciding the game’s
aesthetic by littering a desk full of cloth, felt, and
yarn whilst figuring out prototypes. The design
THE DREAM MACHINE
was cute, warm, and safe – but the game lacked
Similarly, Jack King-Spooner, creator of bizarre
a real hook to keep players invested. Nintendo
platform adventure game, Sluggish Morss: Pattern
suggested transforming the project into a Kirby
Circus says: “When
game, which would
making the models, I like
add a level of structure
“What is important is that
to experiment. Some
and fun. Integrating
people share the same love
I simply take a bit of
Kirby, an existing
of creating things”
modelling clay and a bit
character, gave the
of wire and play until
game the substance it
something or other starts revealing itself. Some
needed – his presence turned a lacklustre game
characters have a bit more planning behind
with an interesting aesthetic into something
them, with sketches and concept art.“
truly worth playing
Experience as a developer and having worked
HAL Laboratory, which got involved at a later
with real materials in game design, or having
stage in character creation, was glad to be
made a handmade game, would make a very
taking a surprising direction with the design of
rare applicant for any studio. Luke Whittaker,
the game, when other developers at the time
co-founder of BAFTA award-winning studio
were trying to get closer to realistic-looking
State of Play, explains: “What is important is
digital graphics. The real-life materials – digitally
that people share the same love of creating
photographed and ‘pasted’ over in-engine
things. There’s a general outlook on what
polygons – heightened the warmth and
games are and could be, which we look for.
cosiness of a cute character, but in a new and
Sometimes we’d look for skilled model makers
unexpected way. It helped to show that bending
to help with certain scenes, but the team has
original ideas and encouraging new ones is
been multidisciplinary. Our developers have an
often a necessary part of turning something
artistic eye, and our artists understand the basis
good into something great.
for how things will work.”
So it seems that experimenting is at the heart
UNPREDICTABILITY
of handmade games, not only in fusing together
The very nature of designing games built from
various materials to make a vision come to life,
everyday objects is unpredictable. Whether
real sets, figure out which materials will work
and which won’t, and potentially cope with
something falling to bits, requiring extra time
to correct it. This involves hours of physical
labour and the willingness to bend your plans
– and your artistic vision – to make unexpected
changes fit, all without warping your end goal.
“If an idea couldn’t be built on a small IKEA
desktop, with some dirt and two twigs, we just
had to come up with a different idea,” says cofounder of Cockroach Inc, Anders Gustafsson.

Stop-motion
Kombat
The early 1990s saw Mortal
Kombat famously digitise real
actors into a gory brawler, but
it was Visual Concepts that
took things to a more tactile
level. ClayFighters, released in
1993 on SNES (and later, Mega
Drive) featured a claymation
style of animation in a game
parodying the likes of MK and
Street Fighter. Its animation
was achieved by making real
clay (or plasticine) models of
combatants, and laboriously
digitising traditional stopmotion photography via that
most reliable of workhorses:
an Amiga.



 nders Gustafsson, one
A
half of Swedish indie
studio, Cockroach Inc.

wfmag.cc

\ 21

Interface





Plasticine, not pixels

 ntil you see Luke standing
U
next to the set for scale, you
don’t realise just how vast
the handmade Lumino City
set really is.

 tiny portion of the intricate
A
set of Lumino City, made from
paper, card, and mini lights.

Craft in work

you’re building dollhouse-esque sets in your
bedroom like the Slow Bros. with Harold Halibut,
crafting weird dreamlike environments from
condoms and pork chops in a small basement, à
la The Dream Machine, or using paper and wires
in a huge handcrafted set (as in Lumino City),
there are bound to be setbacks or surprises
along the way. Whether that’s because materials
themselves can act differently to what you
expect, or because they spontaneously decide
to crumble halfway through building a set or
character, designing games using real-life odds
and ends can – and does – present unique
challenges that all the planning in the world may
not prepare a team for.
Consider how some everyday objects may
look inside a game: using recognisable items
like bottle tops and labels is going to have a
profound effect on the surrounding characters.
For example, they could make your world
seem ‘miniature’ – think of how Yarny looks in
the surroundings of Unravel compared to the
life-size furniture, cups, and plants. If it’s not an

effect that fits your storyline, then it may need
to be swapped for something less conspicuous.
Your time frame always has to be kept in the
back of the mind – figuring out which materials
work and rebuilding sets that look wrong or fail
in some way can take weeks or even months,
and can put a big dent in deadlines.
Learning about materials and how they
connect to the characters and story is a
fundamental part of getting better at creating
games using real-world materials, but by
spending too long on one area, it’s fair to say
others get neglected and the entire game could
suffer. “We somehow spent three weeks trying
to get the roof of the photographer’s house
right,” says Whittaker. “It looks like the leather
folded front of an old camera, but just using
one taken off a camera wouldn’t have looked
right. So we spent ages folding paper, refolding
and colouring it with different inks. It took too
long, really, but it did help us work out that
visual language.”

INVOLVING THE COMMUNITY

There’s more than one way to enjoy the game
worlds created for us by talented developers.
When we’re not playing the levels and have
powered off our consoles and PCs, we can find
comfort and enjoyment in the characters – and
the worlds they live in – by creating our very own
versions of them. With handmade games, this is
even more rewarding, because what we craft out
of crochet, papercraft, or plasticine actually looks
just like those gracing the screen. We don’t have
to try and imagine what sketches or paintings
would look like in pixel form, or even learn how
to use pixel art programs or how to create
polygons. Instead, handmade games fulfil the



“I’ve rediscovered a love of
making things by hand,” says
State of Play’s Luke Whittaker,
“and learned that other people
respond emotionally in a
similar way to me to seeing
craft in the work. It seems like a
crazy pitch, to make a game by
hand, and that’s partly why we
self-funded – I didn’t want to
have to justify it to publishers.
I’ve learned that if it feels right,
it’s worth doing. Others will
likely feel the same.”
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 o-founder and lead designer of
C
State of Play Games, Luke Whittaker.
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Kirby’s Epic Yarn inspired a
re-release on the 3DS,
coming in March 2019.

Kirby’s clay
inspiration
Following the successful
plushie-inspired Kirby game,
Kirby’s Epic Yarn, Nintendo and
HAL Laboratory crafted yet
another game inspired by the
real world, this time in fauxclay: Kirby and the Rainbow
Curse. Released in 2015 on Wii
U, this tribute to claymation is
a gorgeous example of how
well Kirby fits into a cosy,
warm, handmade environment.
Maybe one day HAL will
move into the realm of actual,
physical sets.



 reathtaking Swedish
B
countryside has inspired fans of
the Unravel series to create their
own Yarny models.



creative parts of those outside of gaming, too.
yearn to create in the way that their visions guide
Think of Yoshi’s Woolly World, a game designed
them, but it’s unlikely it’ll ever replace ‘traditional’
to look just like a cosy landscape formed
digital designing. “At the end of the day, it’s just
from plush knitted characters, felt levels, and
a technique. It’s just a way to execute an idea.
fabric scraps. Whilst most of this is computerIf it doesn’t suit the idea, or if the idea stinks,
generated, the amiibos of Yoshi are made from
real-world materials won’t save it,” says Anders
real yarn, thus expertly
Gustafsson, and he has
transposing the faked
“If it doesn’t suit the idea, or a valid point. Although
look of the game to a
we can all appreciate
if the idea stinks, real-world a game’s impressive
very real-world version of
materials won’t save it”
things. A very real-world
graphics, or when a
adorable version, that is.
studio tries something
The developers, the same as those for Kirby’s
new, games are not one-sided and cannot be
Epic Yarn, unsurprisingly, initially decided on
great, innovative, or enjoyable by relying solely
a fabric Yoshi world to bring the warmth and
on one of its attributes.
kindness of the character out in a whole new
REAL VS FAKE
way. What better way for fans to bring him to life
All parts of a game have to work in harmony
off-screen than by crocheting and knitting their
for them to be fun and engaging. A beautifully
own real-life characters, monsters, and levels?
designed game with hollow, shallow characters
It’s not just Nintendo, either – capitalising on
won’t work, the same as an aesthetically
the popularity of the Unravel series, EA released
gorgeous puzzle game with awful physics won’t
an in-depth guide on how to make your own
get away with being sub-par, simply because it’s
version out of yarn and wire, inspiring fans of the
nice to look at.
game to experiment with his design. Hundreds of
In the future, the ‘feeling’ of handmade
fans have since shared their creations on social
games could theoretically get easier to produce,
media, popping their own Yarnys into natural
with photorealistic imagery becoming less
environments just like the Swedish countryside
complicated to make; though whether you’d
found inside the game itself. Real-world materials
want to is another question.
allow fans to carry on the adventure in real life,
The flaws we commonly see in handmade
strengthening the bridge that developers build
games would have to be reproduced in CG,
when imagining their games, using everyday
which is an expensive process by itself (unless,
items that fans can replicate.
of course, you have the financial backing of a
THE FUTURE
company like Nintendo). The process could
also be as time-consuming as building a real
Whether we’re talking about worlds crafted
set, and introduce a whole new host of technical
purely from raw materials and everyday items,
problems by itself.
ones where designers have reimagined or
Besides, it’s those little flaws – the creases,
replicated the feeling through digital artwork,
the fingerprints, the peeling bits of tape – that
or if it’s somewhere in between, there’s no
make games made from real-world materials so
doubt players have a hankering for an authentic
engaging in the first place.
experience. We’re reaching a point in game
development (particularly in the indie scene)
where tools and platforms for creating game
environments are becoming easier to access
and cheaper than ever, so everyone can try
their hand at bringing their imagination and
hard work to life for us to play and enjoy.
Can the same be said for handmade games,
when much of the work is physically crafting the
landscapes, characters, monsters, and puzzles?
Certainly – if the game warrants a particular
style, and it’s in keeping with the game storyline
and characters. Game designers will always
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The Dream Machine used
pork chops, condoms,
lichen… “You name it,
we’ve probably used it.”
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 ”Other than

creating and
implementing all
the battle moves,
which took quite
some time,”
Walton tells us,
he’d designed
and named all
his monsters “in
two days.”

 he once peaceful
T
creatures that live around
Nyoo Owtearowa have
started acting strangely.
It’s up to you to find out
why – or you can ignore
the mystery entirely,
Walton says.

Interactive

Notemon, the tiny monstercatching RPG made in PICO-8
Meet Nick Walton, the solo dev who’s making a
Pokémon homage with a New Zealand flavour

Are you a solo
developer working
on a game you
want to share with
Wireframe? If you’d
like to have your
project featured in
these pages, get
in touch with us at
wfmag.cc/hello

24 / wfmag.cc

I

n September 2018, solo developer
based battling arena game, a game where you
Nick Walton headed to YouTube to
walk around talking with NPCs, a game where
make a confession. “Making Notemon
you collect items for quests. Then after I had
was a mistake,” he wrote in his video’s
that experience I’d be able to put it all together
description, “but I’m committed to it.”
to create one great RPG.”
Nine months earlier, Walton had just begun
Despite the steep learning curve, Walton’s
work on his monster-catching RPG: a blocky,
stuck with his Pokémon-like monster-catcher,
colourful, free-roaming game developed
which has evolved from a straight fan-game
in the virtual console, PICO-8. But while
to something far more personal. Before he
Walton had made plenty of games before,
moved to Houston, Texas in 2015, Walton grew
Notemon quickly proved
up in a small town in New
to be a more ambitious
Zealand, and Notemon is
“I think it would
proposition: as well as
heavily informed by his
have been better if
monster management and
home country’s culture.
exploration, it also contains
The action is largely set in a
I’d broken Notemon
such elements as combat,
peaceful fantasy world called
down into pieces”
fishing, and quests. In other
Nyoo Owtearowa, and its
words, Notemon isn’t just
inhabitants’ dialogue is all
one game, but several games, each woven
written in a phonetic approximation of the New
carefully into the other. As work progressed,
Zealand accent.
Walton gradually realised how much work all
“Notemon doesn’t have any voice acting, but
these elements would require.
I still wanted a way to portray a New Zealand
“With my previous games, I basically picked
accent, as according to my headcanon that’s
one small thing to make the game about,”
how the characters would speak,” Walton says.
Walton tells us. “I think it would have been better
“The idea for writing phonetically just came
if I’d broken Notemon down into pieces and
to me by thinking a little about that problem,
made a small game about each part – a turnand after having some people read it, they all
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” For me, PICO-8 is a cosy crucible, charming in its
presentation yet forcing me to become a better
programmer,” Walton says.

A shot from Notemon when it
was still in its early stages back
in January 2018. It’s changed
quite a bit over the past year.

understood the words and pronounced them
the way a New Zealander would, so I went
with it!”

Notemon also departs from Pokémon in other
ways besides its dialect and setting. For one
thing, players won’t have to fight monsters in
order to capture them; instead, Walton says,
“you build a barn and give them a home so
they’ll join your team.” There are other changes,
too, including stats that restore after a battle
(“You don’t have to walk back to a recovery
location halfway through a cave!”) and moves
that can be changed as you level up, rather than
being overwritten.
Notemon might look diminutive compared
to the latest entries in the Pokémon series, but
Walton remains intent on pushing the virtual
console’s limitations as far as he can. There
are 20 unique monsters to catch, an expansive
game world with multiple locations spread
over nine maps, and a non-linear story that the
players can, Walton says, engage with or ignore
as they see fit.
“If a player just decides to do the main
objectives in the game, they’ll get a lot of
gameplay out of it,” Walton says. “It’s up to the
players how much they get out of Notemon – if
all they want is to build the barn and completely
ignore what’s going on in the world they can do
that, too.”
Fitting all those monsters and locations
into PICO-8 has, Walton tells us, been one of
the biggest challenges of making Notemon
– though he also adds that fighting against
the system’s limitations has been a valuable
learning experience.
“I have a love-hate relationship with PICO-8,”
says Walton, “but ultimately I think it has been
very educational to me as a game designer and
programmer. PICO-8 has a cartridge size of
32kB, and I chose to make Notemon with it so I’d



DOWN ON THE FARM

be forced to decide what’s really important to
the game and cut the rest. Within a very short
time, I found myself hitting the code token limit
without even having all the core features done,
so I figured out a way to spread the game across
[currently] 12 cartridges which all automatically
load between each other when necessary.”
In summary, then, Walton no longer feels as
though he’s made a mistake by embarking on
his deceptively complex top-down RPG project.
“I’d say I’m over the hump,” Walton says, before
listing some of the things he has planned for its
release later in 2019: it’ll be available on Steam,
Game Jolt and itch.io for Linux, Windows, and
Mac as well as PICO-8, and there’ll be a free demo
for would-be monster-catchers to try out, too.
Aside from the appeal of catching and
housing tiny, tiny monsters, it’s those personal
touches mentioned above that really endear
Notemon to us: the quirky NPCs that say things
like, “Aw gidday” or, “My old bahn, shee’s prity
bustid up aye!” For Walton, it’s these little
cultural flourishes that can make an indie game
truly unique.
“I think the more cultural variation we can
have in games, the better,” Walton says. “My aim
with Notemon was to make a great game, and
happily I’ve found that including my New Zealand
culture has only helped that goal.”

 alton used PICO-8’s built-in sprite
W
and map editors to create his
characters and gentle fantasy world.

TUTORIAL
MODE
For Nick Walton, Notemon
is the latest step in a hobby
that’s been developing since
he was a kid growing up in the
quiet town of Feilding, New
Zealand. Early experiments
with GameMaker as a
10-year-old led to a lasting
interest in development. “My
friends all dropped off game
dev, but I kept on with it as
a hobby, learning C++ and
other languages, trying some
game engines and whatnot,”
Walton says. Along the way,
he’s found online tutorials an
invaluable – and often free –
means of learning more about
making games. Says Walton,
“I learned everything I know
through experimentation and
free online tutorials, which is
why I’ve just started making
my own tutorials to pass on
some knowledge.” You can find
Walton’s own YouTube channel
at wfmag.cc/VmwSRi

wfmag.cc

\ 25

Interface
Column

Violent delights
have violent ends

LOTTIE BEVAN
Lottie Bevan is
a producer and
co-founder of the
experimental narrative
microstudio, Weather
Factory, known for
their Lovecraftian
card game, Cultist
Simulator. Before
founding Weather
Factory, she was
producer at Failbetter
Games, where she
worked on Fallen
London, Sunless
Sea, Zubmariner and
Sunless Skies.

“It’s explicitly
not fun if
it actually
happens to
you. I paid
£40 for the
entertainment
experience of
role-playing a
horror victim”
26 / wfmag.cc

stupid, exciting things. It’s much more like actually
being Claire Redfield on the worst day of her life,
and I can see why the designers don’t want people
literally playing it safe. But Claire doesn’t seem to
be enjoying herself, and as my experience now
closely mirrors hers, neither am I.
I respect Resi 2’s decisions. It’s my fault I’m
a coward, not the game’s. But I think this will
keep happening. Increasingly realistic blood
and gore will necessitate increasingly nasty art,
animation and events to inspire the same level of
revulsion. Increasingly normalised violence leads
to increasingly unshockable players, which may
force horror game-makers to nastier and nastier
places. These violent delights have violent ends,
and the more intense they get, the larger the
cohort of the left-behinds. The BioShock players.
The Dead Spacers. The Alien: Isolationists.
‘Dweeb Island’ isn’t a cool address, but the real
tragedy is its inhabitants missing out on otherwise
excellent games. There will undoubtedly be
a rise in alternative horror to fill the growing
demand, and at some point – surely – even video
game nasties will reach their grim apex. For now
though, I’ll just have to get the vegetables in.
Anyone fancy dinner round mine?



I

’m a cowardly, escapist completionist
but even I fell prey to Resident Evil 4.
The grimy art direction, the wet squelch
of gore, the prolonged stress and
terror, the weirdly forgivable sexism,
and (if I’m being honest) Leon S. Kennedy’s fringe
all added up to a surprisingly fun romp through
the Costa del Zomb.
Resis 5 and 6 passed me by, but I was ready
for 7. I’d heard it tried something new: more
immersive than ever. More violent than ever.
More frightening than ever. Fewer hokey Jill
sandwiches, more maggoty, actually-humanflesh sandwiches. Due to my aforementioned
wimpiness, I looped in a friend with an Umbrella
Corp tattoo. In exchange for a few stir-fries,
when the game launched she played it at my
flat rather than hers so I could sort of play it,
too (occasionally cowering behind a wok). Many
nauseating hours later, we looked palely at one
another and put the controller down. It was too
much. The first-person perspective, the high
production values, the basic human horror at
being kidnapped, mutilated and often killed by a
bunch of semi-mutant cannibal maniacs. Horror
is fun when it’s a swirl of fear, safety, tension
and release. It’s explicitly not fun if it actually
happens to you. I paid £40 for the entertainment
experience of role-playing a horror victim. Ethan
Winters would pay a whole lot more to never
experience that again.
The much-hyped Resident Evil 2 remake is, at the
time of writing, about to launch. It looks fantastic,
and not just because Handsome McFringeboy is
back. But I’m sadly unlikely to play it. Once again,
it takes horror to its logical next step, but it isn’t
necessarily a step closer to fun. For example,
it reintroduces Mr. X, a basically indestructible
Dr. Manhattan lookalike who’s been inexplicably
kitted out with a trilby you can shoot off his big
scary head. He sets a frenetic pace: no careful
supply sweeps, no room-by-room zombie culls, no
time to catch your breath. Mr. X and his tiny hat
force you onwards into the fray, dodging fights,
missing pick-ups, and making you do dangerous,

Broad shoulders, tiny hat: Resident Evil 2 ’s terrifying
T-00, also known as Mr. X, or Trenchy to his friends.
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 erfect a smooth Super Mario-like jumping
P
action in Source Code on page 32.



 o make a great city, you also need to
T
consider its surroundings – see page 30.
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The principles
of game design
Great game design requires a mixture
of economy and theatre, Howard writes
AUTHOR
HOWARD SCOTT WARSHAW
Howard is a video game pioneer who authored several
of Atari’s most famous and infamous titles
onceuponatari.com



I

 ricks like cycling colours and
T
altering sizes created a
lively-looking game in just a
few kilobytes of memory.

the rainbow, which gave it the feeling of
morphing; this foreshadowed its transition to
a dangerous super-weapon.
Both techniques added to the visual
impression of the game without any additional
bytes for graphics. The ultimate example of
this kind of economy came when I decided the
centre-left of the screen was too stark, and
needed something for visual balance. What
could I stick in there that would look cool?
The idea of using the game’s code itself for
both graphics and colour (as detailed in the
sidebar of my last article) was a creative and
cost-effective solution, and it’s just so shiny
and twinkly. As a special bonus attraction, it
happened to automatically animate the colour
of the Zorlon Cannon as well.

INNOVATION

No one had ever seen anything like this on the
2600. When people walked by the lab, they
would stop to exclaim, ‘What is that?’ It had no
game purpose at that point, and it didn’t matter.
It was catching eyeballs. It was working!
When it came time to create my big payoff
sequence, the elaborate animation I’d originally
planned seemed like too much work.
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came to Atari with a bachelor’s
degree in mathematics, economics
and theatre, as well as a master’s in
computer engineering. Most people
think the maths and computer
engineering were the keys to success at Atari,
but I believe it was the economy and theatre.
After all, making games on the 2600 is about
finding the most economical approach to
maximising entertainment value. When you only
have 4K of ROM for code and graphics, and a
precious 128 bytes of RAM (including the stack),
well… to paraphrase Monty Python: every byte
is sacred, every byte is great. The big question,
then, is how best to use them?
Keep in mind that my latest game wasn’t yet
called Yars’ Revenge during development – it was
an unnamed project originally assigned as a
conversion of the arcade shooter, Star Castle. My
working title for the game was Time Freeze, but
there was no story concept yet. This means there
was nothing to suggest which way to go next –
but then again, there was nothing restricting my
vision, either. Unfettered by storyline, I only had
to make everything on the screen more visually
stimulating. Naturally, the first place I looked was
the low hanging fruit. What was easy to do on
this machine?
For the player’s Zorlon Cannon, I animated it
very simply by alternating its horizontal size: this
gives the weapon a pulsating impression which
adds motion to the screen even before it’s fired.
Another thing that’s easy to animate on the
2600 is colour: it’s a simple way to add another
visual dynamic. With the Qotile (the game’s
antagonist), I cycled its colour slowly through

 oward Scott
H
Warshaw,
pictured between
bouts of furious
coding in the
early eighties.
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with a simple button push, remember to say,
“Thank you, Howard.”

A GAME OF FIRSTS



Test match
No game was tested more than
Yars’ Revenge. Each time it
seemed the game was going
out, some concern was raised
and another test was ordered.
The test would go well,
release was scheduled and
then another concern arose.
I had a bad case of Releasus
Interruptus. It was killing me.
The real drug at Atari was
seeing your game in stores and
on TV – I wanted that high so
bad I could taste it. And when
it finally happened… it was so
worth the wait.



Yars’ Revenge broke a lot of new ground. On top
of pause mode, reset from joystick, full screen
explosions, and elaborate colour and sound
design, Yars’ Revenge was the first game to
display its code on the screen. Yars’ didn’t have
The original release came with a comic book which
helped fill out the sci-fi backstory to Yars’ Revenge.
the first Easter egg in video games (that was
Adventure), but it was the first time the marketing
Instead, I simply riffed on this Ion Zone
department approved, and got behind, the
technique to create the first full-screen
Easter egg concept. It was also the most
explosion in video game history. Why? Because it
tested game in Atari history. Ultimately, it was
was dazzling and easy to do. Also, each of these
play-tested against the 2600 version of Missile
enhancements was associated with a simple but
Command, and Yars’ won.
unique mini-sound algorithm.
It was nearly the first VCS game to become
Animations were key as well. The Yar’s
a coin-op, too: Dave Theurer (Tempest, Missile
flying animation was originally done for visual
Command) was actually considering making an
interest, but I added
arcade version of Yars.
the more elaborate
“Making games on the 2600 (Spoiler Alert: he didn’t.)
death sequence for
It was the first Atari game
is about finding the most
punctuation. And the
to credit its programmer.
second level shield
Atari’s perennial refusal to
economical approach”
had rotating bricks
do this was a sore point,
which weren’t apparent until the first time it was
which led in part to the formation of Activision.
breached; then the increased motion becomes
And there’s one more industry first for Yars,
an interesting new element. When it came time
but this one will require more space: next time,
to structure the completed game experience,
I’ll talk about the naming of Yars’ Revenge, and
that’s when my resistance to convention really
creating the first video game backstory.
paid off.
I liked the clean feel of the unframed black
background; it gave great contrast for the
glittering colours on the screen. When played
at night with the lights off, the game melted
into the darkness of the room and made it feel
bigger. I liked that effect. Why mess it up with
a score? Besides, doing a separate screen for
scoring gave me several advantages.
First, I didn’t have to mess with my original
code to add anything to the main screen. It was
all working, so why change it? A separate scoring
screen was trivial to program. But what’s huge
is turning control over to the player. Now they
could decide when to restart the game with a
joystick button push. This created a significant
innovation: Yars’ Revenge was the first video
game with pause mode. Most video game
thinking at the time was derived from coin-ops,
where a pause mode was unthinkable. Not so
for home games. I also added the ability to reset
and launch a new game from the joystick after a
loss. So, next time you pause or restart a game

 eavily advertised in the
H
nascent games press, Yars’
Revenge was a hit in 1982.
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CityCraft: designing
a city’s surroundings
What surrounds a city is just as important as the
setting itself, as Konstantinos explains
AUTHOR
KONSTANTINOS DIMOPOULOS

Styles of Empire
Empires, nations and great
collectives spanning star
systems often tend to exhibit
a more or less unifying visual
style. From a commonly seen
flag to a repeated building
typology or prevalence of a
colour, some sort of aesthetic
cohesiveness is usually
displayed. This isn’t mandatory,
of course, but repeated
architectural and planning
rhythms can make an imperial
space instantly recognisable
as such. An orthogonal
town with an amphitheatre,
columned temples, and a
rigid grid-based road system
would, for example, be instantly
identifiable as part of the
Roman Empire.



 ig 1: By-rivers link into rivers
F
flowing away from linear
mountain ranges and towards
the sea, providing humans
with settlements options.

Konstantinos Dimopoulos is a game urbanist and
designer, currently working on the Virtual Cities atlas,
and consulting on several games. game-cities.com

A

s a strategy, sieges are based
on the assumption that the
vast majority of cities could
never grow their own food.
It’s true that surrounding
areas (or hinterlands) most commonly sustain
urban centres, and that vast fleets of freighter
spaceships keep fully urbanised planets like
Star Wars’ Coruscant and Warhammer 40,000’s
Terra surviving. The politically dominant
hubs of vast transportation, production and
financial networks were the first to grow to
metropolitan sizes.
Cities, you see, cannot exist in a vacuum. They
need to be connected to other settlements,
function as parts of wider political organisations,
and be in a constant dialogue with their wider
environments. Of course, we don’t need to be
reminded of such realities when recreating New
York City, or when setting a game in Istanbul,
where real-world geography is plain to see. Any
attempt at imaginary city building, though, must
take wider surroundings into account; both
those sculpted by nature, and by human hands.

NATURAL GEOGRAPHIES

Coming up with an environment for your city
involves decisions regarding topography,
geology, climate, flora and fauna: where, and
in what sort of world, is your city located? In
many cases, such answers involve the setting’s
universe (is it ruled by a demented pantheon of
prankster gods?), planets (can urbanism survive
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only in protective domes?), continents (do they
all share similar species?), and an abundance of
details for the specific locations of specific urban
centres. Getting inspired by real topographic,
geological and other thematic maps worked
wonderfully for A Song of Fire and Ice, and can
easily work for your world, too.
Then again, following Tolkien’s more
imaginative example, one could craft everything
from the beginning, keeping in mind that space
is by definition cohesive.
Also, certain basic rules have to be followed
to maintain consistency and ensure a sense
of believability. The processes defining the
formation of mountains and rivers are, for
example, some of the more fundamental ones.
So, mountain ranges, being the result of tectonic
pulls or pushes, are almost exclusively linear,
and never intersect with each other at 90 degree
angles. Mountains also tend to push rivers away
from their mass, and that’s why rivers flowing in
parallel to them often feel wrong.
Rivers, unless thoroughly magical, tend to
flow from higher to lower altitudes until they
reach the sea or a large body of water. What’s
more, rivers only join into bigger ones, and don’t
split up or branch until they reach their deltas.
Admittedly, with nature (imagined or real) being
infinitely varied, such rules needn’t apply to all
situations, and could be redefined by strange
materials, alien technologies and magical forces.
Mordor’s unnatural fortress-shaped mountain
range was the result of Morgoth’s powerful
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 etworks of cities and the importance of geographic
N
connections are evident in games such as Civilization
VI. Urban centres cannot exist in isolation.

Water and
flooding
If the world you’ve constructed
has water and gravity, then that
water will flow downwards.
A city’s lowest points will
therefore be the first to flood,
and will remain flooded only
if something keeps the water
from flowing further away.
Following this logic, drainage
basins would also have to
exist (see Figure 2), which in
turn lead to rivers and lakes.
This might sound obvious,
but you’d be surprised at how
many otherwise masterful
world-builders forget about
flow and flooding.



sorcery, and in distinct contrast to the more
resulted in cities without protective walls,
sensible, Earth-like environment depicted
whereas many northern towns of the declining
in Figure 1.
Byzantine Empire were little more than heavily
Most intriguingly though, (human) societies
fortified outposts.
don’t treat their environment as something
Human geography also includes connections
static. They change, adapt and add to it. They
and networks. Often, an intersection of two
assign value to land
major trade roads
as their needs and
led to the founding
“Societies don’t treat
capabilities change,
of transit towns that
their environment as
and choose where to
with time evolved into
something static”
locate according to their
financial powerhouses.
priorities. A fortified
Transportation, along
position in a valley means nothing on a peaceful
with cultural and trade exchanges, on the other
planet; a natural harbour is worthless when you
hand, can be disrupted by non-natural barriers
cannot sail.
such as China’s Great Wall, or reach new
levels as telecommunications instantaneously
HUMAN GEOGRAPHIES
overcome distances. Hard and soft borders, as
‘Pure’ nature that hasn’t – at least to a tiny
well as state or national ideologies, can further
degree – been influenced by humanity doesn’t
influence architectural trends in cohesive parts
actually exist on contemporary Earth. Deserts
of the world, civic lifestyles, or the kinds of food
have been made to bloom, mountains have
people can buy in a marketplace.
been excavated, islands constructed, rainforests
irrigated, and traces of our emissions have
BELIEVABLE REGIONS
affected Antarctica, and the ocean floor.
In short, location matters, and it’s the combined
In addition to this, we’ve divided land into
effects of imaginary societal and natural
nations, countries, states and kingdoms, each
geographies that can make a region believable,
with its borders, beliefs and economies for
and fill in its details. Morrowind’s tamed Silt
our settlements to function in. Nature and
Striders are one such example, while Terry
society both birthed the geographies we build
Pratchett’s Clacks telecommunications network
on, and there’s no reason why any imaginary
across the Discworld is another.
construct shouldn’t be inspired by our rich
Believable regions have appropriate beasts
geographic histories.
of burden, economies adapted to their dynamic
Technologies dictate how cities are built,
environments, and logical, hierarchical patterns
what activities they need or care for, and
of settlements ranging from villages and
allow for elaborate fortifications. Nations and
towns to cities and metropolises. Specialised
borders often lead to wars, and thus geopolitics
settlements (port cities, holy cities, industrial
are a powerful factor in shaping (or levelling)
cities) might make sense, too – though the ways
urban centres. During the ancient Egyptian
these urban spaces are formed will need a
New Kingdom’s apex, the Pharaoh’s peace
whole CityCraft instalment to themselves.

 ig 2: A drainage basin is a
F
region in which all water is
gathered and drained to a
common outlet. It is divided
in sub-basins.

 bisoft’s Terrapolis (1989)
U
survived harsh planetary
conditions under a dome,
and required temporal
bridges to keep in touch with
the rest of the universe.
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Super Mario-style
jumping physics
AUTHOR
RIK CROSS

B

Learn how to create your own Super Mario-style
running and jumping action in Python

efore writing any code, it’s
best to decide on the rules
of your world. Will you allow
your player to double-jump,
or change direction in midair? There are no right or wrong answers to
these questions, but it pays to plan ahead.
We’ll be using Python and Pygame Zero
to code the game world, but the ideas are
transferable to other languages.
The first thing we need to do is create
a player and some platforms to jump on!
As Pygame Zero has built-in support for
collision detection between game Actors and
rectangles, we’ve stored the platforms as a
list of rectangles with varying dimensions.
As vertical and horizontal motion are
perpendicular to each other, they can be
considered independently. Horizontal
motion will involve moving the player to
the left or right by updating the player’s
x-coordinate if the arrow keys are pressed
(and the player is within the screen bounds).
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This can be improved later, but we’ll keep
this simple initially to concentrate on the
vertical motion. Before writing the code for
vertical motion, let’s look at the physics:
• Acceleration is the rate of change of
velocity. Vertical acceleration is due to
gravity, and is a positive value (i.e. acting
downwards). Gravity will be stored
as a global constant, as it acts on all
game objects.
• Velocity is the rate of change of position.
Initially the player’s vertical velocity will
be 0, as the player is at rest. When the
player jumps, the velocity will be set to a
negative value (i.e. acting upwards).
Both of these values change with respect
to time, which for the sake of simplicity can
be thought of as increasing with each frame.
There’s nothing special about the values
chosen for gravity and jump velocity – these
can be tinkered with to suit. You can also
adjust the height and gaps between the
platforms to increase your game’s challenge.

In each frame, the following algorithm is
used to update the player’s vertical position:
• Add the acceleration value to the
velocity value
• Add the velocity value to the
position value

COLLISION DETECTION

The next thing to fix is that the player’s
velocity (and therefore position) isn’t yet
affected by colliding with a platform. One
way to do this is to calculate the player’s
new position, but only move the player to
the new position if they don’t hit a platform.
If there’s a collision, then the player isn’t
moved, and its velocity is set to 0. No
collision means the player is free to move
to the new position. Making the player jump
is a matter of setting the player’s vertical
velocity to the predefined jump velocity.
However, the player should only be allowed
to jump if there’s a collision. This means
that the player is touching a platform.

Toolbox
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Download
the code
from GitHub:
wfmag.cc/
wfmag7

Jumping physics in Python
Here’s a code snippet that illustrates Rik’s platform-jumping physics in Python. To get it running on your system,
you’ll first need to install Pygame Zero – you can find full instructions at wfmag.cc/XVIIeD

# define screen size
WIDTH = 800
HEIGHT = 800
# define a colour
MAROON = 128,0,0
# vertical acceleration
GRAVITY = 0.2
# a list of platforms, each a rectangle in the form ((x,y)
(w,h))
platforms = [
Rect((0,780),(800,20)),
Rect((200,700),(100,100)),
Rect((400,650),(100,20)),
Rect((600,600),(100,20))
]
# create a player and define initial vertical velocity
player = Actor(‘player’,(50,450), anchor=(‘left’,’top’))
player.w = 20
player.h = 20
# define initial and jump velocities
player.y_velocity = 0
player.jump_velocity = -7
def update():
# horizontal movement
# calculate new horizontal position if arrow keys are
pressed
if keyboard.left and player.x > 0:
player.x -= 2
if keyboard.right and player.x < 780:
player.x += 2
# vertical movement
# temporary variable to store new y position
newy = player.y

# create a rectangle for the new y position
newplayerpositiony =
Rect((player.x,newy),(player.w,player.h))
# check whether the new player position collides with a
platform
y_collision = False
for p in platforms:

# player no longer has vertical velocity if colliding with
platform
if y_collision:
player.y_velocity = 0
# only allow the player to move if it doesn’t collide with
any platforms
else:
player.y = newy
# pressing space sets negative vertical velocity only if
player is on ground
if keyboard.space and y_collision:
player.y_velocity = player.jump_velocity
def draw():
screen.clear()
# draw platforms
for p in platforms:
screen.draw.filled_rect(p,MAROON)
# draw player
player.draw()

MAKING IMPROVEMENTS
We’ve fixed one potential bug, by
only allowing the player to jump if
they’re touching a platform. If you
run the code on the left, though,
you’ll notice a few other bugs:
• The player can jump if they’re
touching any platform, even
if they’re underneath. This
can be fixed by only counting
collisions below the player,
by comparing the player and
platform’s y-coordinates.
• There’s no horizontal collision
detection, so the player can
walk through platforms. This
can be fixed with horizontal
collision detection.
• If the player collides with
a platform at high velocity,
they’ll stop just short of the
platform and then drop slowly
to the ground. One way of
fixing this is to calculate the

distance between the player
and this platform, and move
the player so they’re on top of
the platform they would have
collided with.
These bugs have been fixed in
a second version of the code,
jump_physics_improved.py,
also available in the
GitHub repository link above.


# acceleration is rate of change of velocity
player.y_velocity += GRAVITY
# velocity is rate of change of position
newy += player.y_velocity

y_collision = newplayerpositiony.colliderect(p) or
y_collision

Like Super Meat Boy,
but without the meat.
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Finalising your Unity first-person shooter

Finalising your Unity
first-person shooter
In this third and final part, we’ll finish up our Unity
shooter with visual effects, menus and more
AUTHOR
STUART FRASER
Stuart is a former designer and developer of high-profile
games such as RollerCoaster Tycoon 3 , and has also
worked as a lecturer of games development.

I


 ith the addition of rounds, menus
W
and effects, our project is really
starting to feel like a proper game.

n our earlier tutorials, we
looked at building a first-person
shooter, and worked through
adding gameplay elements
and mechanics, such as firing
a projectile and creating a simple enemy
type. We also added a wave-based survival
mode, which we’ll now explore further by
adding an enemy spawner and rounds.
We’ll also polish the game, adding a
menu system and visual effects to our
projectile hits.

CREATING AN
OBJECT SPAWNER
First, let’s create a spawner that we can
use to spawn multiple enemies. This is
going to be very simple, and we’ve already
used some of this logic to spawn our bullet
object. We’ll also expose some variables or
values so that we can expand the idea of a
wave-based survival mode.
To do this, we need to create a game
object to be our spawner object. You can
simply right-click in the Hierarchy and
select Create Empty. In the Inspector
window for this object, rename it to
Spawner. We’ll add a script that allows
us to choose the object to spawn, the
number of spawned objects, and a delay
between spawns. In Inspector, select Add
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Component and then select New Script
and set the name to Spawner. We can then
double-click the script to open the script
editor of our choice, and then replace the
script with our code. Remember to save
and go back to Unity when you are done.
using System.Collections;
using System.Collections.Generic;
using UnityEngine;
public class Spawner : MonoBehaviour {
public GameObject spawn;
public int amount = 1;
public float delaySpawn = 1;
private int getAmount;
private float timer;
private int spawned;
private void Start()
{
ResetRound();
}
private void ResetRound()
{
getAmount = amount;
}

Toolbox
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void Update () {
timer += Time.deltaTime;
if (delaySpawn < timer)
{
if (spawned< getAmount)
{
//Reset our timer.
timer = 0;
spawned++;
GameObject instance = Instantiate(spawn,
transform);

We made our Zombie enemy a prefab
in our Project in the last tutorial, so we
should be able to select this, and drag it
onto the slot named Spawn that is shown
for the Spawner object in the Inspector
window. You can then delete any other
Zombie objects that are in the Hierarchy,
as we can now spawn them via this
spawner object.

“Let’s add some particle
effects to the action”

public class MoveToPosition :
MonoBehaviour {
private Transform goal;
private NavMeshAgent agent;
void Start()
{
goal = GameObject
FindGameObjectWithTag(“Player”).
transform;

instance.transform.parent
= null;
}
}
}
private void OnDrawGizmos()
{
//Draw the wireframe mesh of what
we intend to spawn in our editor.
Gizmos.color = Color.red;
if (spawn != null)
{
Gizmos.DrawWireMesh(spawn.
GetComponent<MeshFilter>().
sharedMesh,transform.position, spawn.
transform.rotation, Vector3.one);
}
}
}

 hen you drag in the prefab, you’ll
W
see a wireframe outline of the mesh
to help you position it easily.

agent =

Now test the spawner by pressing Play
to preview the game. The first thing you
may notice is that the enemy is spawned,
but it won’t move, and we have an error in
the Unity log. The reason for the issue is
that while we have the Player in our scene,
the Zombie prefab is in the Project so the
engine doesn’t understand this exists.
This is not a huge issue, but we need to
change how we’re going to set the goal for
our AI script.
We need to stop the game playing, and
then we need to select the MoveToPosition
script. The fix is going to use the tags that
we looked at in the second tutorial. We’ll
tell the script to set the goal to the object
with the tag Player as soon as it spawns.
So, open the script and you can replace
the existing code with the changes below.
using UnityEngine;
using UnityEngine.AI;

GetComponent<NavMeshAgent>();
}
void Update()
{
agent.SetDestination(goal.
position);
}
}

Save this, run the game again, and the
error should be gone, and the AI will

CATCHING UP
If you missed the first two parts of this guide,
you can download free PDFs of Wireframe #3
and #5 from wfmag.cc/3 and wfmag.cc/5. You
can also download the complete unity project
from wfmag.cc/UnityFPS
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 he Particle System contains a lot of useful modules
T
that allow you to control your particle effect.

work as before. You can then exit the play
mode and we will look at improving the
look of our projectiles.

ADDING WEAPON
PARTICLE EFFECTS

Let’s add some particle effects to the
action – this will make the game look more
engaging. First, some setup: we’re going
to add another camera. We do this so the
particle hit effects render before the rest
of the scene – otherwise, the particle effect
will clip with whatever it hits. To achieve
this, select the Player in the Hierarchy and
expand it until you find the Main Camera,
then right-click and select Camera. We’ll
get a warning if we have two or more Audio
Listeners on cameras, so select Audio
Listener in the Inspector and then rightclick to remove the component.
Check the Depth on the camera
component is 0 rather than the default
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 he gradient editor allows you to
T
control the transparency and colour
of the particles within a timeline.

of -1. This is telling Unity to render this
camera before the main camera. We’ll also
set the drop-down under Clear Flags to
Depth only. Next, we select the Layer dropdown to the top-right of the Inspector
window and select Add Layer. We’ll now
see the Tags & Layers tab we used on the
last tutorial. We need to expand the Layers
option and then in an active empty layer
type WeaponFX.
Now we need to select our Main Camera
in the Hierarchy, and then in the Inspector
select the Culling Mask drop-down, and
then untick our new WeaponFX layer. You’ll
notice that the drop-down will now say
Mixed – this is the correct behaviour. Now,

“We’ll add a spark
effect on top to make it
more dramatic”
select your new camera and select the
Culling Mask drop-down and then Nothing
from the options. Now reselect the Culling
Mask and tick just the WeaponFX layer.
We’re now ready to create a particle
effect and make it a prefab. To make this
easier, we’ll create a new level – from the
Taskbar, select File > New Scene. Save the
previous scene if you’re prompted. In the
Hierarchy, right-click and select Effects
> Particle System. In the Inspector for
the Particle System, reset the position to
0,0,0 and then expand the Particle System
component. We need to uncheck Looping
and change the parameters of Duration
and Start Lifetime to 0.4, the Start Speed

to 0, and Max Particles to 1. Now expand
the Shape module and then change the
Shape drop-down to Sphere and set the
Scale for the shape to 0,0,0.
If you select Restart from the Particle
Effect window that appears in the Scene
viewport, you’ll see a single particle appear
at a fixed position, then disappear. We’ll
now enable Size over Lifetime module
and the Color over Lifetime module. Open
the Color over Lifetime module and click
the box to the right of the word Color.
You’ll see the Gradient editor. This has
several sets of arrows that control the
transparency or the colour of the particle
over time.
Let’s add a new arrow along the top
by clicking in the same approximate area
as the other down arrows. We select this
arrow and drag it to be about 3/4 along the
top. Now select the down-arrow to the topright and you’ll see an Alpha slider; change
the value from 255 to 0. This should make
a nice fade out when your particle is about
to die off. Next, select the up-arrows that
are along the bottom. This will let you set
colours of your choice. I’ve selected the
same orange colour for both the left and
right arrow, but this is up to your own
artistic choice. Finally, close the Gradient
editor and try replaying your effect by
restarting the playback.
We’ll add an additional spark effect on
top of this to make it more dramatic. With
our Particle System still selected in the
Hierarchy, right-click and select Effects >
Particle System. Select the new Particle
System and then in the Particle System
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timer += Time.deltaTime;
if (timer > maxTime)

THE JOY OF LAYERS

{

Layers are extremely useful and can be applied
to more than camera rendering. We can use
them to specify which lights would cast on an
object, or which objects can interact with each
other. You can find out more about layers from
the Unity documentation: wfmag.cc/sWAQFT



Destroy(gameObject);
}

 he shape module allows you to set the shape of
T
the volume that the effect will be emitted from.

component, unselect Looping and change
the Start Lifetime and Start Size to 0.2,
and the Duration and Start Speed to 2.
Select and open the Emission module
and change Rate over Time to 0 and then
under the Bursts parameter select the
+ to the bottom-right; the defaults are
fine here.
Next, select the Shape module and
change the Shape drop-down to Sphere.
Select the Color over Lifetime module, and
again, open the Gradient editor and set-up
the Alpha and Colour settings to mirror the
ones for the first particle. In the Renderer
module, select the Render Mode dropdown and select Stretch Billboard and then
change the Speed Scale to 0.2 and the
Length Scale to 1.
You can then preview the effects
together; this should be quite satisfying,
but feel free to tweak the settings to your
preference. For ease of identification,
select the first Particle System we made
and in the Inspector name it HitEffect.
One last change is to change the Layer
drop-down to WeaponFX and select Yes,
change children from the prompt.
As an addition, we’ll add a script to
destroy the particle effect so it won’t
clutter our inventory. In the Inspector,
select Add Component, select New Script,
and name this DestroyEffect, then open
the script and replace with the code below.
using UnityEngine;
public class DestroyEffect :
MonoBehaviour
{

}
}

Save the script and then return to the
Unity editor. We’ll now drag this object into
our Project window to make a Prefab. Next,
we load our original scene from the Project
window – you don’t need to save the
current scene, as we have our Prefab.
We now need to make some updates
to our existing scripts. This will allow us
to spawn a particle effect on the exact
point our bullet hits the collider and add
a knockback force to the Zombie enemy.
Let’s first find the BulletHit script in the
Project and double-click to open it. We
then replace the existing script with the
modified code below.
using UnityEngine;

using UnityEngine.AI;
public class MoveToPosition :
MonoBehaviour
{
public float knockbackTime = 1;
public float kick = 1.8f;
private Transform goal;
private NavMeshAgent agent;

public class BulletHit : MonoBehaviour {

private ContactPoint contact;

private bool hit;

public GameObject particle;

private float timer;

//When we touch the collider we

void Start()

disable this object.
void OnCollisionEnter(Collision
other)

{
goal = GameObject
FindGameObjectWithTag(“Player”).
transform;

{
//Find the contact point on the
object we collided with.
ContactPoint contact = other.
contacts[0];
//Set the exact position and
rotation we hit the collider at.
Quaternion rot = Quaternion.
FromToRotation(Vector3.up, contact.
normal);

agent =
GetComponent<NavMeshAgent>();
//Set timer to the same a
knockback in first instance.
timer = knockbackTime;
}
void Update()
{
if (hit)

Vector3 pos = contact.point;

{

//Spawn our particle using the
above parameters.
Instantiate(particle, pos, rot);

// Update is called once per frame

gameObject.SetActive(false);

void Update()
{

using UnityEngine;

using System.Collections;

public float maxTime = 1;
private float timer;

Save this and then we want to open and
replace our MoveToPosition script in a
similar fashion.

}
}

//Allow physics to be
applied.
gameObject.
GetComponent<Rigidbody>().isKinematic =
false;
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//Stop our AI navigation.
gameObject.
GetComponent<NavMeshAgent>().
isStopped=true;
//Push back our enemy with an
impulse force set via the kick value.

AddForceAtPosition(Camera.main.transform.



gameObject.
GetComponent<Rigidbody>().
forward * kick, contact.point, ForceMode.

 he particle effect will appear on
T
any scene geometry that your
projectile hits.

Impulse);
hit = false;
timer = 0;
}
else
{
timer += Time.deltaTime;
//After being knocked back,
restart movement after X seconds.
if (knockbackTime < timer)
{
gameObject.
GetComponent<Rigidbody>().isKinematic =
true;
gameObject.
GetComponent<NavMeshAgent>().isStopped =
false;
agent.
SetDestination(goal.position);
}
}

window and expand it by clicking the rightarrow and select the Bullet mesh. In the
Inspector for the mesh, you should see
our BulletHit script. Select the slot labelled
Particle, click the small circle next to it, and
then select our HitEffect particle Prefab.

DEVELOPING OUR
ROUNDS SYSTEM

We want to add a rounds system. For this,
we’ll make a new Game Object. Go to the
Hierarchy, right-click in an empty space,
and select Create Empty. In the Inspector,
rename this object to GameManager. We
then select Add Component and then New
Script and call the script GameManager,
then we will open this and add the
code below.
using System.Collections.Generic;
using UnityEngine.UI;

void OnCollisionEnter(Collision
other)

using UnityEngine.SceneManagement;
public class Spawners

{
//We compare the tag in the other

{
public GameObject go;

object to the tag name we set earlier.

{

public Spawners(GameObject newGo,
bool newBool)
go = newGo;

hit = true;

active = newBool;

}
}

Save this script and move back to Unity
editor, select the Projectile in the Project

38 / wfmag.cc

public static event RestartRounds
RoundComplete;
private int health;
private int roundsSurived;
private int currentRound;
private PlayerDamage playerDamage;
private Text panelText;
public List<Spawners> spawner = new
List<Spawners>();
void Start () {
Time.timeScale = 1;
panel.SetActive(false);
playerDamage = GameObject.
FindGameObjectWithTag(“Player”).
GetComponent<PlayerDamage>();
panelText = panel.
GetComponentInChildren<Text>();
foreach (GameObject
go in GameObject.
FindObjectsOfType(typeof(GameObject)))
{
if (go.name.
Contains(“Spawner”))
{

{

contact = other.contacts[0];

}

public delegate void RestartRounds();

public bool active;

if (other.transform.
CompareTag(“bullet”))

public GameObject panel;

using System.Collections;
using UnityEngine;

}

{

spawner.Add(new
Spawners(go, true));
}

}
}
public class GameManager : MonoBehaviour

}
}
void Update () {
int total = 0;
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health = playerDamage.health;
if (health > 0)
{
for (int i = spawner.Count 1; i >= 0; i--)
{
if (spawner[i].
go.GetComponent<Spawner>().spawnsDead)
{
total++;
}
}

We now need to update the Spawner
script. This is because we want to be able
to trigger the spawners to restart when
we’ve completed a round. The manager will
look at when all the spawners are marked
as depleted and restart spawning when a
new round initialises. So we need to open
our Spawner script and replace it with our
updates below.
using System;
using System.Collections;
using System.Collections.Generic;

if (total == spawner.Count &&
roundsSurived == currentRound)
{
roundsSurived++;

using UnityEngine;

{
public GameObject go;
public bool active;

string.Format(“Round {0} Completed!”,
panel.SetActive(true);

public Enemy (GameObject newGo, bool

{
currentRound =
roundsSurived;
RoundComplete();
panel.SetActive(false);
}

//Removes the spawned object
from the spawner object.
instance.transform.parent =
null;
instance.SetActive(false);
}
ResetRound();
}
public void ResetRound()
{
spawnsDead = false;
getAmount = amount;
spawned = 0;

}

{
if (Input.GetButton(“Fire2”))
{
Scene current =
SceneManager.GetActiveScene();
SceneManager.
LoadScene(current.name);
}
else

}
public class Spawner : MonoBehaviour

void Update()

{
public GameObject spawn;
public int amount = 1;

private int getAmount;
private float timer;
private int spawned;
private int enemyDead;

panel.SetActive(true);
panelText.text =
string.Format(“Survived {0} Rounds”,
roundsSurived);
Time.timeScale = 0;

{
//Increase timer per frame.
timer += Time.deltaTime;
//Do the spawn if our timer is
larger than the delay spawn we set.
if (delaySpawn < timer)
{
//And we haven’t reached the
spawn amount.
if (spawned < getAmount)

public List<Enemy> enemies = new
List<Enemy>();
public void Start()

{

enemyDead = 0;
}

public bool spawnsDead;

else

timer = 0;

active = newBool;

public float delaySpawn = 1;

}

}

enemies.Add(new
Enemy(instance, false));

go = newGo;

currentRound && Input.GetButton(“Fire2”))

}

GameObject instance =
Instantiate(spawn, transform);

{

if (roundsSurived !=

}

//Create the prefab as an
instance.

newBool)

}

}

spawned++;

public class Enemy

panelText.text =
roundsSurived);

//Increment the amount
spawned count.

{
GameManager.RoundComplete +=
ResetRound;
ResetRound();
while (spawned < getAmount)
{

NOISES OFF
You can easily add sound effects to game
objects by using the Audio Source component.
By default, these will play the audio as soon
as the object is active in the scene. You can
import standard audio formats: MP3, WAV, and
OGG. A great addition is to add a weapon firing
audio effect to your bullet prefab; each shot will
then play the effect on spawning.
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Gizmos.color = Color.red;
if (spawn != null)
{
Gizmos.DrawWireMesh(spawn.
GetComponent<MeshFilter>().sharedMesh,
transform.position, spawn.transform.



rotation, Vector3.one);
}

 onsider adding some tips/instructions
C
to your scoreboard for your players.

}
}

{

if (enemies[i].
//Reset our timer.

go.activeSelf == false && enemies[i].

timer = 0;

active == true)

//Set our bool to track

{

the state of the enemy.
enemies[spawned].active
= true;

//Reset the spawn
position and set our tracking bool that
they are not active.

//Set the enemy to be
active.

enemies[i].

We need to make one very small
change to an existing script. Open the
EnemyDamage script and replace this with:
using UnityEngine;
public class EnemyDamage : MonoBehaviour
{
private int hitNumber;

go.transform.position = transform.
enemies[spawned].

position;

go.SetActive(true);
//Get ready to set

private void OnEnable()

enemies[i].active =

{

false;

isKinematic.

hitNumber = 0;

enemyDead++;

}

}
StartCoroutine(SetKinematic(spawned));

}

void OnCollisionEnter(Collision

//Increment the amount
spawned count.

if (enemyDead == enemies.
spawned++;

{

Count)

}

{

for (int i = enemies.Count -

}

if (other.transform.
spawnsDead = true;

1; i >= 0; i--)

}

{

other)

}

CompareTag(“bullet”))
{
//If the comparison is true,
we increase the hit number.
hitNumber++;

//If another script
disabled the object but we set them

IEnumerator SetKinematic(int id)

active above.

{

}
if (hitNumber == 3)
{

//We set isKinematic at the start

gameObject.SetActive(false);

of the next frame to avoid confusion with

}

other commands.
yield return null;

AMAZING SCENES
You can create a game object with a script that
is persistent in your scene (or set of scenes)
and will not get disabled or deleted. Essentially,
they take in input from other scripts, can control
elements in other game objects, and help
manage other elements of gameplay. I tend to
refer to these game objects as managers, but
you may see these called a slightly different
name elsewhere.

enemies[id].
go.GetComponent<Rigidbody>().isKinematic
= true;
}
private void OnDrawGizmos()
{
//Draw the wireframe mesh of what
we intend to spawn in our editor.
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}
}

DISPLAYING OUR
ROUNDS SCOREBOARD

We’ll also set up a new Panel in our canvas,
this will let us display a round scoreboard
and a message when you run out of health.
In the Hierarchy, right-click the Canvas and
select UI > Panel. Select the new Panel
and in the Inspector change the name to

Toolbox
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ScorePanel. You might want to change
some of the other parameters in the Image
component, such as the opacity and colour
of the panel image.
We now right-click in the Hierarchy
with the new panel still highlighted and
choose UI > Text. You can try changing the
Alignment, font size and colour of the text
component in the Inspector. Once you’re
happy with the look of the panel, select
the GameManager object and drag the
ScorePanel into the slot called Panel on
the Inspector window.
We now have a complete experience in
terms of our game loop; we’ll know when
we’ve completed a round, and when we
get down to no-health we’ll see the total
rounds complete and have a chance to
restart the game. To progress to the next
round or to restart, we can use the binding
for Fire2 which equates to the right-mouse
button or left ALT on the keyboard.

IMPLEMENTING OUR
GAME FRONT-END

You should also change the values for
the width and height of the Rect Transform
to 300 by 200. Choose a font size of about
70 and set your alignments to the centre
for the Text component. You can then
come up with a title for your game; I chose
Zombie Panic for mine.
We’ll make two buttons; one to start
a new game and the other to exit. First,
select the Panel from the Hierarchy,
then right-click and select UI > Button.
We then repeat the process to add our
second button. The two buttons will be
overlaid, so with the second button still
selected, we can use the move tool. Select
the green arrow that’s pointing up in the
Scene window, then drag it downwards
when highlighted.

“We should have a
complete experience in
terms of our game loop”
Next, we’ll expand the Button object by
selecting the right-arrow next to it in the
Hierarchy. You should see another Text
object attached. Select this and then in the
Inspector change the text from Button to
Exit. We expand the first button we created
and repeat the process; however, we want
to replace text with Start.
We need to make a script to start or
exit the game. We can then link this to the
buttons with an OnClick event. First, select
the Canvas in the Hierarchy and then in
the Inspector select Add Component.
We then select New Script and name this
MenuScript, then open it ready to replace
it with the code below.

public void ExitGame()
{
Application.Quit();
}
}

Save the script and return to Unity
editor, then we can reselect the first
Button we created. In the Inspector, look
for the OnClick option. To the bottomright is a +, so click this and a new entry
will appear. Select the Canvas and drop
this into the slot that displays None
(Object). Now select the drop-down
that says No Function and then choose
MenuScript > StartGame. Repeat the step
with our exit button, but this time choose
MenuScript > ExitGame.
We now save this scene by selecting
File > Save Scene as… from the taskbar,
then go back to the taskbar and select Build
Settings. In the new window, select the Add
Open Scenes button. Close the window
and now load our game scene. Next, select
Build Settings and again Add Open Scenes.
We’re now in the position to make an
executable. All we need to do is select Build
and Run, select a suitable folder and file
name for the game, and Save.
We’ll now be able to try our menu
system and play through the entire
experience from start to finish. There
are still many more improvements we
can make, but you can see how we’re
building up the layers of a complete
game experience.



It would be quite cool to add a front-end
menu and be able to play through the
game as a standalone executable like any
other PC game. Let’s start with the main
menu first, and create a new scene by
selecting File > New Scene and saving our
current work.
In the new scene, go into the Hierarchy
and right-click and select UI > Canvas. Next,
right-click and select UI > Panel. As with
the score panel, try changing the defaults
to give this a look and feel that suits your
game. Again, keep the panel selected, then
right-click and select UI > Text.
I’d place this at the top of the canvas by
selecting the Anchor Presets from the Rect
Transform in the Inspector. Remember
last time, where we held the SHIFT key to
change the behaviour of the anchor? We’ll
do this again and then select the icon with
the blue dot at the top-middle of the inner
square. You’ll then need to type in the
value of 0 to Pos Y.

 ust using the UI elements
J
we are familiar with, we
can create our title screen.

 aving the spawns separated and in
H
their own ‘caves’ increases the challenge.

using UnityEngine;
using UnityEngine.SceneManagement;
public class MenuScript : MonoBehaviour {
public void StartGame()
{
SceneManager.LoadScene(1);
}
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Representing data:
a free online course
Want to know how to manipulate images, video and
sound with computers? Then check out the Raspberry Pi
Foundation’s new online course
GET
INVOLVED
Do you have an online
course you’d like to share
with readers? Have you
created an online resource
that other game developers
might find useful? Maybe
you have a local code club
you’re keen to promote? If
you have something you’d
like to see featured in the
Directory, get in touch with
us at wfmag.cc/hello

What’s the thinking behind
the course?
We wanted to present some of the more
theoretical parts of the subject in a fun, practical
and engaging way. Data is everywhere – it’s such
an important topic nowadays, with real world
impact, so we’ve made sure it’s useful for anyone
who wants to learn about data through the lens
of creative media.

Who is it for?
Anyone who wants to understand how
computers convert data into digital media such
as images, sound, text and video. This might
be someone who is thinking about a career
using digital technologies and wants to build
a solid basis of understanding. It’s also great
for secondary school-aged students who are
learning about this topic as part of their studies.

What will I get?
By the end of the course, you’ll be able to:
• Describe how computers represent things
in binary
• Produce your own emoji in bitmap and
vector forms
 It’s alive! Raspberry

Pi’s new, free online
course will teach you
all about the process
of turning data into
images and sound.
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•
•
•

 nderstand lossy and lossless compression
U
Understand common text encoding (ASCII
and UTF-8)
Investigate the physics of sound, and
how sampling allows computers to
represent sounds

The take-away will be an understanding of how
computers present to you all the media you view
on your phone, screens etc, and you’ll gain some
new skills to manipulate and change what you
see and hear through computers.

How much do you need to know
before you start?
A basic understanding of Python. Taking our
Programming 101 course on FutureLearn (also
free) would be sufficient.

Where do I sign up?
Visit our course page: rpf.io/datawf

LIFTING THE LID ON VIDEO GAMES

Download the app
Out now for smartphones & tablets

Save

45%
with an annual
subscription

£1.99

rolling subscription

or

£34.99
subscribe for a year

Interface

Dream on: Inside the Dreamcast’s homebrew scene

DREAM

N

Inside the Dreamcast’s homebrew scene



WRITTEN BY
ROBIN WILDE

 etro Sumus test out updated
R
builds using the Dreamcast
Broadband Adapter, which
saves on blank CDs.
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Despite its apparent death 17 years ago, the Sega Dreamcast
still has a hardcore group of developers behind it

I

n 1998, the release of the Dreamcast
gave Sega an opportunity to turn
around its fortunes in the home
console market. The firm’s earlier
system, the Saturn, though host to
some beloved titles, was running a distant third
in sales behind the Nintendo 64 and PlayStation.
The Dreamcast, by contrast, saw a successful
launch and quickly became the go-to system for
arcade-quality ports of fighting games, among
other groundbreaking titles like Seaman and
Crazy Taxi.
Unfortunately for fans, it wasn’t to last. The
Dreamcast struggled to compete against the
PlayStation 2, which launched in 2000, and
at the end of March 2001, in the face of the
imminent launch of the Nintendo GameCube
and Microsoft’s new Xbox, Dreamcast left
the stage, and Sega abandoned the console
market altogether.

None of this stopped a vibrant homebrew
development scene springing up around the
console in Sega’s place, and even years later,
the Dreamcast remains a thriving venue for
indie developers. Roel van Mastbergen codes
for Senile Team, the developers of Intrepid Izzy,
a puzzle platformer coming soon to the PC, PS4
and Dreamcast. Of the port to Sega’s ageing
console, van Mastbergen tells us, “I started
this project with only the PC in mind. I’m more
used to developing for older hardware, though,
so I tend to write code with low CPU and RAM
requirements by force of habit. At some point
I decided to see if I could get it running on the
Dreamcast, and I was happy to find that it ran
almost perfectly on the first try.”
One of the pluses of the Dreamcast, van
Mastbergen points out, is how easy it is to
develop for. “There are free tools and sufficient
documentation available, and you can run your
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 oshProd’s games are a mix of
J
new homebrew and ports of
classic games – with the blessing
of the original developers where
they can get it.

INTO THE
FUTURE



own code on a standard Dreamcast without any
to complete its Dreamcast exclusive, which
hardware modifications or hacks.”
began development in 2006. It eventually raised
Games burned to CD will play in most models
€28,000 – more than treble its goal.
of unmodified Dreamcast, usually with no extra
Intrepid Izzy didn’t quite reach such dizzying
software required. While this doesn’t result in
heights, only just meeting its €35,000 target, but
a huge market – the customer base for new
van Mastbergen is clear it wouldn’t have been
Dreamcast games is difficult to measure but
funded at all without the dedicated Dreamcast
certainly small – it makes development for
base. “The project has been under-funded since
original hardware
the beginning, which is
far more viable than
slightly problematic,”
“One of the pluses of the
the need for often
van Mastbergen tells
Dreamcast is how easy it is
expensive and
us. “Even so, it is true
to develop for”
difficult to install
that the Dreamcast
modchips needed for
community is
other systems.
responsible for the lion’s share of the funding,
Many of the games now being developed for
which is a testament to how well-loved this
the system are available as digital downloads,
system still is.”
but the state of Dreamcast emulation lags
behind that of its competitors, with no
TRICKS AND TOOLS
equivalent to the popular Dolphin and PCSX2
Carlos Oliveros, whose team Retro Sumus are
emulators for GameCube and PS2. All this
developing Xenocider, the console’s first fully-3D
makes boxed games on discs more viable than
game in 17 years, agrees that there’s still life in
on other systems – and, in many cases, physical
the Dreamcast: “The Dreamcast has some quite
games can also become prized collectors’ items.
good open-source tools for developing games,
and extensive documentation is available,” he

With no more physical
hardware being produced, is
there a risk that eventually
development will dry up?
Roel van Mastbergen
doesn’t think so: “New
hardware has been invented
to replace worn-out parts,
and the number of games
released annually has
actually increased in recent
years. Also, considering that
people are still making new
games for hardware from
the 1970s to this day,
I wouldn’t be at all surprised
if new Dreamcast games
will be made another 20
years from now.”

Intrepid Izzy is developed with a
custom code library that works
across multiple systems; it’s simple
to downscale PC assets and export a
Dreamcast binary.

KICKSTARTING DREAMS

By now, you might be asking yourself what the
point is of developing for these old systems –
especially when creating games for PC is a much
easier and potentially more profitable route to
take. When it comes to crowdfunding, though,
catering to a niche but dedicated audience can
pay dividends.
Belgian developer Alice Team, creators of Alice
Dreams Tournament, asked for €8,000 in funding
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accessible from a developer’s perspective” he
says, before admitting the console has no real
advantages over more modern systems. “Just
three words for you,” Lancha adds. “16MB of
RAM. Talk about insignificant. That really is the
biggest challenge!”
Sturmwind made news on release in 2013 as
one of the first of a new generation of boxed
Dreamcast games. German studio Duranik
developed the side-scrolling shooter, starting in
2006. Johannes Graf, who developed the game
alongside his brother, says that on starting
out, developing for the Dreamcast was an easy
choice. “Modern consoles were not an option,
as we developed the game only in our free
Xenocider, in development for
Dreamcast since 2015, combines old
time and there was no easy access to devkits
hardware with new tools, including
for modern consoles back then,” Graf tells us.
3D modelling work done in Blender.
“PC would have been an option but we are not
so much PC gamers. Also, we always loved ‘old’
machines like the Dreamcast, Mega Drive, SNES,
Lynx and Jaguar.”
While the USA and Europe saw their last official Dreamcast games in 2002, Sega
Developing for the Dreamcast also has
continued to license new releases up until 2007 in Japan – long after the release of nextanother advantage, Graf notes: it’s a much
generation consoles. Triggerheart Exelica and Karous were the last two titles to receive
smaller market to enter than, say, Steam.
the manufacturer’s blessing, and were both vertically scrolling shoot-’em-ups ported from
arcades. The shoot-’em-up genre has continued to be a staple of Dreamcast development
“Most of these new marketplaces are
well into the homebrew era.
completely crowded; there are maybe a couple
of thousand new apps released for the mobile
platforms every day,” says Graf. “How do you
says. “Sure, there is nothing remotely as versatile
want to get at least a bit of visibility there? With
as Unity, but you can create a little something
the retro platforms, it’s completely different – if
here and there in a reasonable amount of time…
there are 10 to 20 new releases a year, it’s a lot.”
and it’s not nearly as frustrating as developing
With crowdfunding able to bring these dreams
for the Saturn!”
to life, it might be surprising that publishers,
Xenocider has been in
of a kind, still operate in
development for four
the Dreamcast homebrew
“The Dreamcast is
years, and is largely built
community. But JoshProd,
special because it was
on all-new technology.
relatively new on the scene,
the last arcade-inspired
It’s a 3D shooter inspired
does just that, producing
Duranik’s 2013 shoot-’em-up,
console in history”
by Sega’s arcade classic,
high-quality boxed releases
Sturmwind, was the only
Space Harrier, with,
for new games. These have
homebrew Dreamcast game that
year – since then, over 25 new
Oliveros says, “a heavy influence from Treasure’s
even included mainstream titles, with the last
titles have seen release.
Sin & Punishment, which we realised later when
couple of years seeing the release of Delphine
we were creating the first assets for the game.”
Software’s nineties classic action-adventures,
Physical releases for Dreamcast
The game’s engine, Dreamer, was built from
Another World and Flashback.
can be a big event – Sturmwind
the ground up by Daniel Lancha, who goes
launched with a special edition
including Krakor, one of the
by the handle Chui. He’s a big name in the
PUBLISHING AND
game’s bosses.
community, and was responsible for dreaming
DISTRIBUTION
up a variety of tools, including ports of the
Like Daniel Lancha, Philippe Nguyen of JoshProd
popular SDL and OpenGL libraries, as well as a
says the main limitation is the Dreamcast’s
range of emulators.
16MB of RAM, which bottlenecks the scope for
“The Dreamcast is special because, in my
new ideas. “We had to cancel lots of good games
opinion, it was the last arcade-based, or arcadelike Gigantic Army or Infinos Gaiden,” he says.
inspired, console in history. Besides, it is pretty
Nguyen’s justification for working around these



LIVING THE DREAM
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difficulties, however, echoes other developers
we spoke to. “The reply is simple: passion and
nostalgia,” Nguyen tells us. “You don’t make
money with Dreamcast, you make a part of
game history”.
Boxed releases slot well into the existing
infrastructure for console mods and homebrew
games. Michael Mrozek runs DragonBox, a
German-based online store selling everything
from replacement Nintendo 64 analogue sticks
to independent releases for a range of consoles,
including the Game Boy Advance, Mega Drive
and, naturally, the Dreamcast.
“Dreamcast games sell really well, to be
honest – better than cartridge-based games,”
Mrozek says. “I can imagine that one of the
reasons is the price: homebrew titles usually
tend to be a lot simpler than commercial titles,
with some exceptions like Sturmwind, Wind and
Water: Puzzle Battles or the upcoming Intrepid
Izzy, or Tanglewood for the Mega Drive. While
high-quality games like Sturmwind sell well for
a normal retail price, a lot of customers can’t
justify having to pay a high price for more simple
titles. On the Dreamcast, that’s not that big a
problem, as producing the discs is very cheap,
so you can sell simple games for a small and
reasonable price.”
While custom cartridges for the Mega Drive
are available, they sell on DragonBox for €11
apiece, without counting the additional cost
of the hardware to write the ROMs to the
carts. With such a high markup for production,
Dreamcast games typically cost less than half as
much as Mega Drive titles.
Around 60 homebrew games have now
been released for the Dreamcast in total – a
significant percentage of the console’s entire



It runs at a lower resolution than on PC, but Intrepid Izzy
still maintains a smooth 60fps on Dreamcast.

I zzy’s costumes allow her to change abilities to
navigate levels and tackle enemies. This gothic
outfit lets her turn into a bat, naturally.

library – and, to date, there’s no sign of the
scene slowing down. While developers may be
pitching for a limited audience, it’s one that is
still captivated by the possibility of a console that
many feel didn’t fulfil its potential in its own time.
With more games being released year on year –
and with ambitious 3D games like Xenocider on
the way – it’s clear that this small community is
still dreaming big.

REGION
FREE
The Dreamcast
development scene is
surprisingly geographically
concentrated, with most
current developers based
in mainland Europe –
particularly Germany, Spain
and France. Definitive sales
figures for the console
are hard to find, but those
available indicate sales
of less than two million in
Europe. “Dreamcast games
sell about the same here as
international, which is pretty
good,” DragonBox’s Michael
Mrozek says, but can’t offer
any explanation for the
high number of developers
in the region. “Because no
one can do it as good as we
can,” he suggests.





Dream on: Inside
inside the Dreamcast’s homebrew scene

 he VMU has a homebrew scene
T
of its own, with apps and ports of
Pac-Man and Tetris available.

wfmag.cc

\ 47

Interface

xxxxxxxxxxxxxxx
Hot
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Hot and cold
Veteran writer Chris Avellone tells us about the
beguiling world of Degrees of Separation

Info

GENRE
Puzzle platformer
FORMAT
PC / PS4
DEVELOPER
Moondrop
PUBLISHER
Modus Games
RELEASE
Out now



 wo worlds, one love, lots of
T
platforms to overcome.
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egrees of Separation grabs you by
the eyeballs. With its marionettestyle animation, reminiscent of
one Earnest Evans on the Mega
Drive, it’s immediately different.
The visuals on this page pop; they’re gorgeous.
It’s alluring – beguiling, even. Norwegian studio
Moondrop has done a great job of making
something that does the hard work of standing
out in a crowded market, and that’s a talent
that hasn’t come on suddenly.
See, Moondrop has been making steady
progress over the past decade, releasing a
couple of pretty-looking puzzle titles, each
to a positive reception. Kesper’s Keep was a
browser-based puzzle-platformer released in
2011, involving smart use of light and colour in
its brainteasers. Amphora saw the studio make
its way into the big leagues of Steam, and the
physics-based puzzler – the gorgeous physicsbased puzzler – went down well with the limited
audience it was exposed to.
This time, though, Degrees of Separation is
gunning for the attention of far more – it wants
a bigger audience, and it has already snagged
a name to add credence (and quality prose) to
the game’s story: Chris Avellone. The freelance
narrative designer/writer made his name on the
likes of Fallout, Planescape: Torment and other
classic story-heavy CRPGs. As such, the move

to a less narratively-focused title was a
surprising one – but it hasn’t impacted Avellone’s
ability to put together a compelling tale.
“From the perspective of constructing a game
narrative,” he explains, “rather than adopting
a linear structure, sometimes presenting story
elements that reflect the player’s own pace and
approach to each challenge, and also reflecting
what world/area/region the player selects to
explore, is more in keeping with what makes a
game a game – in these instances, you’re not
dictating the narrative, you’re supporting the
player’s journey, and Degrees is very much that
type of game.”
Degrees of Separation tells the tale of two
characters, Ember and Rime, whose love
for each other compels the two of them to
overcome an enforced separation by harnessing
each soul’s powers of heat and cold.
“I hadn’t tried my hand at writing romance and
relationships in games before – or at least not
to this extent,” Avellone explains. “I wanted to try
it because I felt it would be a challenge – but as
it turns out, Degrees provided something even
more: it not only had a romantic component but
a romantic component that was being presented
in a mature fashion.
“It wasn’t simply infatuation and elation
and happily-ever-after and all the upsides of
a relationship. Moondrop went further and

Interface

presented a relationship arc that included many
of the challenges we all face in relationships
– conflict, uncertainty, hesitation, doubt – and
Moondrop’s desire to include those elements in
both the narrative and gameplay arcs felt very
honest to me.”
Of course, this being a puzzle-platformer, it
is something more focused on the actual game
people play rather than the tale being told, but
that story pushes things along and frames it
did the system and level design and I never felt
in an emotional context most might not have
the need to interject as the design of the title
otherwise expected.
was clear from the outset.
When you’re solving puzzles because they’re
“I don’t think I ever had a single ‘gameplay
there, that’s one thing; but when you solve them
mechanic’ comment on the title. And seeing
to drive forward a narrative you’re honestly
the systems and levels laid out and being able
invested in, it becomes a whole other… well,
to play through them allowed me to focus on
story. Just take a look at
a narrative structure
Braid, for example.
that reinforced the
“Correlation between
“When there’s a clear
game’s mechanics and
narrative and mechanics
correlation between
level design.”
makes any story stronger”
the narrative and the
It may be a move that
game mechanics, that’s
surprised those who
something I think makes any game storyline
have followed his career over the years, with
stronger versus being divorced from the
an arguably darker, certainly more ‘traditional’
mechanics,” agrees Avellone. “In Degrees,
background to Avellone’s titles. But he doesn’t
the game mechanics mirror the emotional
think the bright colours and bright fantasy of
challenges Rime and Ember are facing, and both
Degrees in any way holds it back: “Degrees is not
the game and the story are better for it.”
a fairy tale,” he says.
The writer’s involvement in the creative
“It asks deeper questions about relationships
process amounted to – you may be surprised
and the spectrum of emotions relationships
to hear – writing. However, that’s not because
can go through, and not all of them are positive,
Avellone is a man lacking in opinions or drive
which feels honest. And in being honest… that’s
to help make a project better if he can – it’s just
a positive thing.”
because the developers did what Avellone sees
as impressive heavy lifting: “I didn’t provide input
into the game design itself,” he says. “Moondrop


Degrees aims to tell a mature,
honest story of relationships.



Hot and cold

 he game’s animation is an almost
T
marionette style, limbs articulating
with abandon.

WORK/LIFE
BALANCE
Since leaving Obsidian
Entertainment, a company
he co-founded, Avellone
has found plenty of work on
the freelance circuit. You
might be annoyed with him
popping up on the credits
of so many games, but his
decades-long career shows
the man has serious stylistic
chops with the written word.
Away from the Obsidian fold,
Avellone has seen credits
on the likes of Torment:
Tides of Numenera, Prey,
Into the Breach, Omensight,
the System Shock remake,
and Dying Light 2. Degrees
of Separation sits in some
fine company, and should
benefit from the substantial
experience Avellone affords.
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Tokuro Fujiwara
The quietly ‘scary’ pioneer behind the survival horror
genre, and too many Capcom classics to name

K

onami’s loss was, it soon
turned out, Capcom’s
gain. Then a 21-year-old
graduate, Tokuro Fujiwara
joined Konami in 1982,
where he designed two moderately
successful arcade games: Pooyan, a
curious shooting game with cartoon
pigs, and Roc‘n Rope, an actionplatformer with an unusual grappling
hook mechanic. After just one year,
however, Fujiwara was poached from
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under Konami’s noses by Capcom – a
rival firm that had decided to branch
out into the video game development
market in 1983.
Although far from a household name,
Fujiwara’s 13-year run at Capcom
would result in some of the company’s
most celebrated video games. In
1985, he directed the hit arcade
game, Commando – an up-the-screen
blaster that, with its military theme and
relentless action, sparked a wave of
imitators, most notably SNK’s cheekily
similar Ikari Warriors, released less than
one year later. While Commando was
being developed, Fujiwara was also
working on an equally bold arcade title –

Tokuro Fujiwara

\
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released in 1996: both share the same
mansion setting, and both use things
a side-scrolling action platformer with an
like limited inventories and resources
unusual Gothic horror theme. The result
to generate suspense. Fujiwara himself
was Ghosts ‘n Goblins, released just a few
certainly had Sweet Home in mind
months after Commando, and another
when he began work on what would
major success for Capcom.
become Resident Evil; he later recalled
Had Fujiwara only worked on arcade
in an interview that, with the improved
games for the rest of his career, he
hardware of Sony’s PlayStation now at
still would’ve deserved a place in the
his disposal, he wanted to create an
medium’s history
original horror game
for his early titles
that contained all
“Fujiwara’s work is
alone: 1987’s Bionic
the things he was
varied, but the best of forced to leave out of
Commando was an
it is laced with horror” Sweet Home.
ingenious upgrade
on the concept
Directed by Shinji
he first dreamed up in Roc‘n Rope for
Mikami, Resident Evil was nevertheless
Konami; 1988 sequel, Ghouls ‘n Ghosts,
heavily influenced by Fujiwara, who
improved on its Ghosts ‘n Goblins
served as co-producer. Fujiwara once
predecessor in just about every way.
claimed that Mikami hated horror
movies, and was reluctant to embark
PATIENT ZERO
on making a game with a horror theme;
It was when Fujiwara – reluctantly at
Fujiwara eventually coaxed him into
first – moved over to Capcom’s console
taking the project on, reasoning that
game development team that his most
someone who experienced fear so
innovative work emerged. He produced
acutely would be far more adept at
the NES sequel, Mega Man 2, in 1988,
making a scary game than a director
which became a 1.5 million-selling
who didn’t.
smash, and continued to work on the
Looking back over his career to
franchise until the mid-nineties. In 1989,
date, Fujiwara’s work is varied, but the
meanwhile, Fujiwara directed a relatively
best of it is often laced with horror.
low-key game called Sweet Home. Based
Lest we forget, the NES version of
on a Japanese horror film of the same
Bionic Commando concluded with its
name, it was a change of pace from
antagonist’s head exploding in a crimson
the relentless action of Fujiwara’s
shower – a foreshadowing, perhaps, not
earlier games. A top-down RPG set in
only of the splashes of claret we’d see
a haunted mansion, Sweet Home was
in Sweet Home and Resident Evil, but also
tense, mysterious, and was – despite
the blackly comical fountains of blood on
the limitations of its host platform, the
display in PlatinumGames’ MadWorld, the
Japanese NES – surprisingly tense.
Wii brawler he co-designed in 2009.
Although never released in the West,
Of Fujiwara’s appetite for the violent,
due to Nintendo of America’s aversion
the exciting, the gory and the outlandish,
to gore and violence, Sweet Home was
maybe Shinji Mikami put it best. “He is a
a patient zero for the survival horror
scary master for me,” he said in an oftgenre. In retrospect, it’s easy to see
quoted interview from 2001. “He’s not
how Sweet Home’s ideas informed the
big or macho, and he doesn’t raise his
later, far more successful Resident Evil,
voice either, but he is really scary.”

After 13 years at Capcom, Fujiwara grew
weary with the firm’s focus on making
sequels to its biggest franchises, which at
the time included Mega Man and Street
Fighter. He therefore left in late 1995, shortly
before the release of Resident Evil, to pursue
his own projects. Of these, two were horrorthemed: the chilly Extermination, released
for the PS2 in 2001, and which trod similar
ground to Resident Evil. Hungry Ghosts,
created for the same platform and launched
two years later, offered a mesmerising
first-person descent into the afterlife. It was
a unique experience that, frustratingly, never
saw a release outside Japan.



 ne of Fujiwara’s last arcade games, Ghouls
O
‘n Ghosts, was something of a masterpiece.





Occult horror

Fujiwara’s horror games, Sweet Home
and Hungry Ghosts, were never released
outside Japan. Both deserve to be more
widely played.

 esigner and producer Tokuro Fujiwara.
D
Photo courtesy of Alex Aniel.
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Tokuro Fujiwara

Blood and thunder
10 of Fujiwara’s finest

Fujiwara’s cracking coin-ops and creepy console classics

01

02

03

Ghosts ‘n Goblins

Commando

Arcade / various

Arcade / various

1985

1985

Bionic Commando
Arcade / NES

1987

The arcade version was OK, but it was the NES

Fujiwara’s horror comes laced with comedy:

Action movies starring lone soldiers were all

the player’s knight famously loses his armour

the rage in the mid-eighties, and Fujiwara’s

port that really brought Bionic Commando to

when touched by zombies and other monsters,

relentless up-the-screen blaster Commando

the masses. An innovative platformer, with the

revealing a pair of boxer shorts beneath. The

(whether it meant to or not) tapped into the

player swinging and climbing with a grappling

humour helped disguise how brutally hard

jingoistic zeitgeist. Even on the battlefield, there

arm rather than jumping, the game’s design

Ghosts ‘n Goblins is; Fujiwara reportedly

are comic flourishes: note how enemies wave

ideas are still being widely borrowed today.

adjusted the game several times before release

their arms and legs when they’re hit. Copycat

Capcom’s own 2009 reboot was, sadly, a flawed

to make it even harder to beat.

shooters from rival developers soon followed.

sales disappointment.

04

05

Ghouls ‘n Ghosts
Arcade / various
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1988

Mega Man 2
NES

1988

A refinement of the original game’s premise,

With the rising popularity of consoles, Fujiwara

Ghouls ‘n Ghosts is nevertheless a superior

was convinced to move to that side of Capcom’s

follow-up. Still fiercely hard, and still bursting

business in the late eighties. His first task in his

with energy and ideas – the pixel art and

new role was to oversee the production of Mega

animation is easily among the best of its era.

Man 2 – a double-or-quits sequel that even he

Fujiwara would later return to the series he

wasn’t sure about making at first. All the unpaid

created with Ultimate Ghosts ‘n Goblins on the

overtime soon proved worthwhile: unlike its

PSP in 2006 – to date, his last game as director.

predecessor, this would go on to be a smash hit.
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06

07

08

DuckTales

Sweet Home

NES

NES ( Japan-only)

1989

1989

Resident Evil
PlayStation / PC / Sega Saturn

1996

The fluffy Disney licence aside, DuckTales

Had this horror RPG been released in the

With its overbearing sense of scarcity and

offers more pixel-precise platforming action

West, its brilliance may have been appreciated

claustrophobia, Resident Evil ’s impact is still

from the Mega Man team, and a neat mechanic

earlier. Instead, it took several years, and a

being felt over 20 years later. Taking the basic

that allows Uncle Scrooge to bounce on his

rock-solid fan translation, before Sweet Home’s

premise from Sweet Home – characters

cane like a pogo stick. Still regarded as a

contribution to the survival horror genre was

trapped in a horror-filled mansion – it took

classic, DuckTales would receive a 21st century

finally understood. More than a dry-run for

full advantage of the then-new PlayStation’s

remake, and an homage, of sorts, in Yacht Club’s

Resident Evil, this is a classic game in its

hardware with its atmospheric lighting and

similarly bouncy platformer, Shovel Knight.

own right.

cinematic camera angles.

09

10

MadWorld

Hungry Ghosts
PlayStation 2 ( Japan-only)

2003

Wii

2009

Offering nothing less than a journey across the

A ferocious brawler that allowed players to

hereafter, Hungry Ghosts offered a genuinely

bash in heads and chainsaw off limbs with a

unsettling first-person horror experience.

waggle of the Wii remote, MadWorld sparked

Obscure even at the time of its launch, this is

controversy, but failed to make a splash in

one Fujiwara joint that sorely deserves a belated

terms of sales. Like many late Fujiwara games,

worldwide release – we could even imagine

though, MadWorld soon found a cult audience.

Hungry Ghosts working as a skin-crawling

Spiritual sequel Anarchy Reigns, made without

virtual reality title.

Fujiwara’s input, was far less satisfying.
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Info

GENRE
Survival Horror
FORMAT
PS4 (tested) /
XBO / PC
DEVELOPER
Capcom
PUBLISHER
Capcom
PRICE
£44.99
RELEASE
Out now

REVIEWED BY
Ian Dransfield

It was always going to be
the Tyrant, wasn’t it? Mr. X
himself is nothing less than
panic-inducing, relentlessly
pursuing the player and
leaving very few areas
actually safe – even some
you would think have to be.
Come your third or fourth
playthrough, this stomping
monstrosity still manages to
wedge your heart at the very
top of your throat.
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When there’s no more room in Hell, the dead will be remade in 4K

I

nventory management, staring at map
screens, and paying careful attention
to how many bullets you have left (it’s
usually ‘not enough’): Resident Evil 2’s
2019 remake can be boiled down to
elements like these without being too facetious.
On one hand, it’s a fine nod back to the 1998
original, of which this is a complete remake – not
a remaster, not a mere update. On the other
hand, it’s the kind of thing – when you describe it
as a space-managing, map-staring, bullet-fretting
exercise in paying attention – that makes Resident
Evil 2 sound… shall we say, ‘uninspiring’. And yet,
Resident Evil 2 is the best since the series began.
That’s all down to the simple fact, as simple as
something like this could ever be, that Capcom
has entirely captured the spirit of the original.
The oppressive atmosphere of working your way
through a claustrophobic police station, knowing
full well the city around you has gone to hell, is
present and accounted for. The giddy terror of
being jump-scared out of your boots by a licker
dropping in from above is just as pulse-wrecking
as it ever was. And, in so very many ways, the
modern Resident Evil 2 ups the ante – not least of
which through its very smart, very frightening use
of one particular enemy: the Tyrant.

You might fight off most zombies in relative
comfort, choosing to inflict a bit of damage
before skirting around the edges of a room
and moving on to save ammo. You might sneak
past those lickers, or throw a few bullet-bones
for the undead pooches littering the place. But,
at certain points in the game, there’s an ever
present stomp-stomp-stomp, reminding you and
your blood pressure that there’s a more serious
threat on its way. And he is always on his way.
The Tyrant, to borrow a fitting phrase, will not
stop, ever, until you are dead. That’s quite a lot
of pressure to have to deal with.
But there is respite to be had, and that’s what
pushes you on: the desire to be safe. To get this
over with and escape. Resident Evil 2 manages to
make you feel as desperate and flustered as its
protagonists, Claire Redfield and Leon Kennedy
– no mean feat.



HIGHLIGHT

Resident Evil 2

 ou’ll soon learn that
Y
while it’s in short supply,
fire is a good friend.

Rated

 laire and Leon spend most of their time
C
apart, though their survivor’s bond is strong.

I t’s not really the sort of
welcome you expect in a
new job…

VERDICT
As a remake, it’s glorious.
As its own thing, it’s
brilliant. A stellar effort
by Capcom.

86%



So, you invest in it, it draws you in, and the
more it draws you in, the more the recipe works.
Before you know it, Resident Evil 2 has you
perched on the edge of your seat, lights down
low, headphones firmly in place, begging it not to
scare you again. You just need to make it to the
another playthrough of the main game with the
next area; to find that key to move on and get
odd different route thrown in. Puzzles are largely
one step closer to safety. Stomp-stomp-stomp.
the same, items required are the same, and
Problems rear their heads, and no
beyond a few notes from the other character,
playthrough is free from feelings of slight
there’s little to show you’re working your way
irritation every now and then. The backtracking
through the story parallel to them. And the
might be accurate to Resident Evil’s past – and
lack of impact between the two runs is jarring,
that of survival horror in general – but it really
coming from a Resi 2 vet: having to weigh up
does feel like a waste of time.
whether or not to grab the machine gun in your
It’s also striking just how linear your
playthrough of A – knowing it would mean it
movement is, with extraordinarily few occasions
wouldn’t be there for the character in the more
in which you’re able to even mantle, and even
difficult B – was a genuinely tough choice.
fewer where you can climb things (at least
Again though, it’s not ruinous. It just couldn’t
without a ladder).
be. Resident Evil 2 manages to expertly straddle
Enemies can sometimes
the line between homage
feel unfair with regards to
and entirely new game, and
“Resident Evil 2 is
how often, how quickly and
in both respects it’s a huge
the best since the
how accurately they can grab/
success. It feels old, but plays
series began”
attack… puzzles are often
new; it carries the imagery
illogical (though obvious) at
of the original, but looks
best… Look, we’re clutching at straws – nothing
spectacular by 2019’s standards. Resident Evil
is ruinous, and most of it does just hark back to
2 makes a fantastic case for the importance
what Resident Evil 2 was to begin with.
of revisiting – and honouring – gaming’s past,
It’s not a free running simulator, it isn’t a
while at the same time not overshadowing
series of logical physics-based puzzles, and the
or forgetting about the original. It is, in short,
threat of the zombie (et al) hordes is meant to
bloody brilliant.
scare and frustrate. So it’s a flimsy argument
to say this brings the experience down in any
real way, as my irritation at any of these factors
quickly drifted away.
One aspect I’m not so forgiving of is the way
in which the first and second scenarios intersect
and impact one another – or, I should say, how
they don’t.
In the original, the A and B scenario for each
character saw plenty of moments replayed from
a different angle, fundamentally different routes
taken and – importantly – decisions made in A
directly impacting the situation in B.
Famous scenes from the original
While there is bisection between the first and
are given a new lease of life,
second stories in this remake, generally it’s just
often with spectacular results.
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HIGHLIGHT
It has to be the music.
Its chugging, some might
say obvious metal music
underpins Dusk in the way
you’d expect of any true
nineties shooter, but the
score by Andrew Hulshult
is absolutely perfect for
the game. It drives you, it
inspires you, sometimes
it even scares you – but
whatever it does, it always
rocks you.

Review





 he action is sometimes
T
scary, but mostly frenetic.

Guess where you have to go…

DUSK
Yes, these are actual PC game screenshots

Info

GENRE
First-person
shooter
FORMAT
PC (tested)
DEVELOPER
David
Szymanski
PUBLISHER
New Blood
Interactive
PRICE
£15.00
RELEASE
Out now

REVIEWED BY
Ian Dransfield

VERDICT
One of the best shooters
of the nineties arrived in
2018, for some reason.

81%
58 / wfmag.cc

I

t’s so much more than a shallow
smartly designed levels, hunting a variety of
emulation of nostalgia. Dusk –
coloured keys, blasting an ever-increasing array
somehow, some way – manages to be
of enemies, and just trying to get to the exit. It
one of the best shooters the nineties
doesn’t sound like much on paper, admittedly,
ever produced, but it was made 20
but there’s the feel of the thing that just nudges
years later using Unity. My brain is frazzled from
it, pushes it, and bundles it into the realms of
the pace, the unforgiving nature, the sheer thrill
something genuinely great.
of it all, and I am so completely happy that this
Dusk doesn’t faff about; it respects you as a
FPS anachronism exists.
player, it respects your time, it respects your
The obvious influence is Quake – I mean, just
ability. It’s hard at times, sure, but it’s never unfair.
look at it – but there are nods to plenty of other
If you’re good enough, you can do it. And it’s
shooters from the nineties
open enough to let you
“Dusk doesn’t faff about; tackle things your own
and beyond: Doom,
Duke Nukem 3D, Redneck
way, allowing levels to be
it respects you as a
Rampage, S.T.A.L.K.E.R.,
selected with any loadout
player, it respects
Blood… you get the point.
you so require. This isn’t
your time, it respects
From a pure aesthetic
about Szymanski forcing
standpoint, Dusk nails it
you to endure his vision: it’s
your ability”
– it looks and sounds the
about you using the tools
part, with a chugging, intense metal soundtrack
the developer provides to have a good time. And
backing up all the quick-paced, blasty action. From
sometimes be a bit scared, especially when you’re
the perspective of the tributes it offers to those
playing with headphones on.
that came before, Dusk is respectful, somewhat
Dusk isn’t a tribute, an ode, a nineties-style
fawning, and – again – absolutely nails it.
facade over a paper-thin set of mechanics. It is a
But all of that really becomes window dressing
legitimately good first-person shooter: consistent
once you get stuck into the game proper: Dusk
in the fun it offers; the challenge it throws at the
is brilliant fun. You’re not looking at recharging
player; and the creativity running through to its
health and waist-high cover, carrying two
very core. I came in expecting a neat little tribute
weapons (no more than that) and travelling
to the games I loved 20 years ago (and still do
from A to B in order to trigger a cutscene. No,
love, admittedly), but I came away with a modern
in Dusk you’re – very quickly – scooting around
favourite. Dusk is fantastic.

Rated
Review

HIGHLIGHT
As demonstrated by Moss
last year, a story told with a
diorama is a comfortable fit
for VR, except A Fisherman’s
Tale essentially has you
in a diorama, within a
diorama. You also get an
old-fashioned storytelling
vibe as the narrator doubles
as the voices of the
other characters.

Review



A Fisherman’s Tale

 o keep this potentially infinite concept simple,
T
puzzles are limited to just interacting with three
layers: yourself, your larger self and your smaller self.

A mind-bending story inside your VR headset
you aim your Move controller at a trajectory,
which is fine when you want to move from one
side of the room to the other, but awkward when
you’re just trying to reposition yourself about
a foot to the left. Another mechanic extending
your puppet arms should solve the problem
of interacting with items just out of reach – an
issue I’ve had with SUPERHOT VR – but because
it’s limited to one setting, it often results in your
arms then becoming too far out, so I’m having to
stretch my arm backwards so my hand can come
back within an item’s grasp. There’s also some
clumsy glitches where things get stuck through a
wall, in which case you’ll have to wait around for
an item to respawn in its original location.
Control issues aside, A Fisherman’s Tale is also
yet another very short VR-based narrative. That’s
not to say this land-dwelling fisherman’s quest
needs to be dragged out, but when its mechanics
are this inventive, I feel that it could have easily
been used to sustain more inventive puzzles
around a game not limited to its short narrative.
To paraphrase a certain character, I could do
with more – and bigger – fish.

Info

GENRE
Adventure / Puzzle
FORMAT
PSVR (tested) / Vive /
Rift / Windows MR
DEVELOPER
Innerspace VR
PUBLISHER
Vertigo Games
PRICE
£11.99 (PSVR)
£13.99 (Steam)
RELEASE
Out now

REVIEWED BY
Alan Wen

VERDICT
An original but shortlived VR narrative, while
awkward controls interfere
with its clever ideas.



W

hen it comes to games, the
player is the puppet master of
every protagonist you assume
the role of. It’s an idea
Innerspace’s immersive VR
adventure, A Fisherman’s Tale, doesn’t shy away
from, since it casts you in the role of a puppet.
Specifically, you’re a puppet resembling your
fisherman creator, who frankly isn’t much of a
fisherman, as the narrator tells you about how
he spends his days in his cabin building models,
including an exact replica of the house where
you both live. The house also has a cabin model
with a fisherman puppet inside, who in turn has
his own model cabin. Or wait, is your master also
just a puppet himself who might have another
creator? It really is a mind-bending Matryoshka
doll of a paradox.
To keep things relatively grounded, the game
prioritises your puppet’s perspective, so you’re
the sentient one whose actions will be mimicked
by the other versions of you. Hunch over your
fisherman’s cabin diorama in the centre of your
room, then look up, and you’ll see your giant
master also peering from above.
This is where the fun comes in, as you’re
required to solve a series of puzzles that cleverly
play with scale, such as how dropping a fun-sized
object into your model cabin results in a larger
version of the same object dropped into your
cabin by your giant self, or vice versa.
But for all A Fisherman’s Tale’s storybook
wonder, the experience is often hampered by
the controls. In PSVR, locomotion is done by
teleporting, but instead of blinking to set points,

 his giant fish is one
T
of the few bizarre
characters you’ll meet.

65%
wfmag.cc
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Rated
Review

HIGHLIGHT
While most of the minigames in Pikuniku are
mostly one-and-done
diversions, the one you can
always easily return to at the
starting village is Baskick,
a simple but hilarious 1v1
basketball game played with
your feet, and where kicking
your opponent is fair game.
Unsurprisingly, it’s also
available in multiplayer.



 he orange fella
T
is Niku and only
appears in co-op.
Technically, you’re
only playing half
the game if you skip
this mode, then.

Review



Pikuniku

 hort at only nine levels
S
long, but still a delight.

Joyfully sticking, rolling and kicking it to the man

FORMAT
Switch (tested)
/ PC
DEVELOPER
Sectordub
PUBLISHER
Devolver
Digital
PRICE
£11.69 (Switch)
£10.29 (Steam)
RELEASE
Out now

REVIEWED BY
Alan Wen

VERDICT
No chin-stroking here,
Pikuniku is simply a joyous
and varied little adventure.

79%
60 / wfmag.cc

M

From being first mistaken as a ‘ghastly beast’
to joining an underground resistance against Mr.
Sunshine, it’s a brief and breezy journey, carried
by a whimsical score from Calum Bowen. While
nothing is exactly designed to challenge you, it’s
more about giving you a variety of things to play
around with, from a rhythm-action dance-off to
boss battles against big robots.
It’s also worth splitting the Joy-Con with a
friend for a standalone local co-op mode. While it
only consists of nine levels, it’s almost like playing
a platforming version of Snipperclips, with some
fun variation, bringing up split-screen when
required, missions that see you both tethered
together, or an impromptu competitive race.
It’s charmingly compact then, perfectly
content with dropping a bit of joy into your life
without overstaying its welcome. But it’s also
the stuff that veers off-path that makes Pikuniku
a delight. From coins to collect, weird junk to
spend it on, even physical trophies that are
wrapped up like presents – a fine consolation
for the Switch’s lack of an in-built system – has a
dystopia ever felt this good?



Info

GENRE
Puzzle
adventure

aybe I’m just getting old, but it
seems almost impossible to look
at a seemingly innocent-looking
children’s cartoon aesthetic
and not wonder if there’s a
more sinister or profound message going on
underneath. So when Pikuniku, a seemingly
innocent-looking game with characters that
look as simplistically drawn as the Mr. Men, is
marketed by publisher Devolver Digital as a
dystopia, it’s hard to resist an eye-roll.
Fortunately, those fears are unfounded. Sure,
there’s a greedy pink-faced capitalist calling
himself Mr. Sunshine handing out ‘free money’
to the villagers of an island in exchange for
plundering its natural resources, but with this
out of the way, Sectordub doesn’t pause for any
deep state commentary. It just wants you to
have a jolly good time.
It’s a sensation you get from the moment you
wake up from a cave as Piku, cuteness incarnate
with minimalist effort. For just a red oval with
a pair of lanky legs and a pair of dots for eyes,
he’s surprisingly expressive as you bounce him
around this childlike 2D world, as he’s capable
of rolling around and through tight spaces, or
using his long legs to kick switches, boxes or
other hapless denizens, whether that’s to solve
a puzzle or just for, um, kicks. Better still, his
leg also doubles as a lasso to swing on hooks
or race up zip wires. Jumping may be a little too
floaty, but for a game that’s more adventure
than platformer, traversal feels wonderful.

 here’s a dystopian
T
theme, but it’s subtle.

Rated
Review

HIGHLIGHT
Pang Adventures has a neat
scoring system baked in.
There’s points gained in the
level and for time left, of
course, but also bonus points
for not missing a single shot.
Each stage has its own target
score, which is something
to aim for. It’s a good way of
keeping you playing, trying to
top your own high score and
attain perfection.

Pang Adventures



Review

 osses look OK, but aren’t
B
the game’s high point.

An arcade classic pops up again, but has its bubble burst?



Info

T

his latest iteration of cult arcade
Pang’s appeal lies not just in quick-fire arcade
franchise Pang arrives on the
reactions, but in how each stage presents its own
Switch, having been out for
challenge. Obstacles like platforms and ladders
a couple of years on other
alter the trajectory of a bouncing sphere, and
platforms. Vintage gamers reading
the way power-ups alter your abilities mean
this will probably already be familiar with Pang
stages require a modicum of thought – as well as
due to its excellent home conversions, appearing
accurate blasting – to complete.
on everything from the humble ZX Spectrum to
Pastagames have done a fantastic job in
the Amiga to Amstrad’s doomed GX4000.
capturing the look and feel of the original
For the newcomers among you, Pang involves
arcade game, even if Pang Adventures doesn’t
popping a screen full of bouncing bubbles with
quite capture the charm and personality of, say,
your harpoon gun, progressively splitting each
Monster Boy – another recent game based on a
one into two smaller bubbles until each screen
classic franchise.
is cleared. This time, though,
Some major difficulty spikes
“It’s addictive,
there are aliens involved, as
are another minus, especially
well as a selection of new
during boss battles. There’s no
particularly in
power-ups, including shotguns
obvious indicator of where or
two-player co-op”
and ninja stars. Basically,
when to shoot your harpoon
though, Pang Adventures’ mechanics – essentially
into the alien slimeball that stands between you
Asteroids crossed with Space Invaders – remain
and the next level, which feels like a bit of an
the same as they were back in the late 1980s.
oversight at best.
Despite this, Pang will still provide hours
of retro fun – it’s a curiously addictive game,
particularly in its two-player co-op mode, which
has always been the series’ strongest point.
There’s something about the chaos of dodging
bubbles and vying for vital power-ups that never
quite gets old.
Alongside the main Tour mode, there are also
two other modes to unlock after finishing the
main game, which really put your bubble-blasting
skills to the test.
Pastagames haven’t revolutionised Pang as we
Pang ’s standard harpoons
know it here, but all the same, you could do a lot
are joined by a range of
worse than popping this on your Switch.
new weapons.

GENRE
Arcade puzzle
FORMAT
Switch (tested) / PC
/ PS4 / Xbox One /
iOS / Android
DEVELOPER
Pastagames
PUBLISHER
DotEmu
PRICE
£7.99
RELEASE
Out now

REVIEWED BY
Jake Laverde

VERDICT
Pastagame’s revision
feels most at home on the
Switch. Perfect for killing
time during your lunch
hour, commute or bout
of insomnia.

69%
wfmag.cc
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Rated
Review

HIGHLIGHT
Rainswept ’s art style is
drenched with colour, and
some of its locations and
scenes look spectacular: a
hilltop cathedral silhouetted
by the sun and a dazzling
fireworks display are two
particular high points.

Review





 ichael Stone: good detective,
M
terrible dancer.

 he grim case is offset by
T
some beautiful artwork.

Rainswept
Play detective in a short yet compelling point-and-click mystery

Info

GENRE
Pointand-click
adventure
FORMAT
PC (tested) /
Mac / Linux
DEVELOPER
Frostwood
Interactive
PUBLISHER
Frostwood
Interactive
PRICE
£9.29
RELEASE
Out now

REVIEWED BY
George Sturgeon

VERDICT
With an intriguing story and
superb visuals, Rainswept
is an absorbing little
detective thriller.

72%
62 / wfmag.cc

A

silhouetted figure, the sound of
a single gunshot, and a crimethriller soundtrack set the noirish
tone for Armaan Sandhu’s pointand-click adventure, Rainswept.
It’s a two-dimensional murder-mystery, with
jaded detectives, philosophical discussions about
tea, and, with its small-town location fringed
by pine trees, obvious parallels to the classic
television series, Twin Peaks.
Although there are locations to explore and
puzzles to solve, Rainswept is driven primarily
by its story, which is a design choice that has
its advantages and pitfalls: it doesn’t stray far
from the template set by earlier point-and-click
adventures, and the player’s path through its
narrative can feel somewhat narrow. Stick with
it, though, and you’ll find a gripping case with
plenty of twists, all wrapped up in a captivating,
minimalist art style.
The town’s cast of residents are surprisingly
well-developed, and the story’s lighter character
beats help leaven the bleak mood that surrounds
your murder investigation – Detective Michael
Stone is a likeable protagonist, and his awkward
dance moves following a few drinks at a bar are
a particular highlight, while his forthright manner
and strong sense of obligation make him an
endearing presence.
Other characters display some fascinatingly
erratic behaviour, leading to plenty of
discoveries as the case continues to unravel.
There’s the terse-yet-empathetic Officer Blunt;

Grandpa, eccentric owner of the local bakery
and prone to angry outbursts; and shy, young,
aspiring photographer, Johnny – as well as plenty
more. It’s a well-rounded and engaging cast a lot
of the time, and serves Rainswept well.
Some characters have their own secrets and
hidden agendas, too, capable of diverting Stone
down alternate paths. Away from the main cast
(and side characters), there are the overheard
conversations referencing video games and
well-worn tropes. It paints a fuller picture of this
world, and it just works.
Sandhu’s game design, art direction, and
story are perfectly complemented by micAmic’s
varied soundtrack; reminiscent of a late eighties’
detective show, it ranges from slow piano
melodies to smooth jazz playing in the local cafe.
The interface is engaging, too: flicking
through the detective’s notepad, which contains
character observations, sketches, and other
notes, I couldn’t help thinking of that old family
favourite, Cluedo. There are still a few bugs,
however, such as action wheels not responding
to mouse clicks and autosaving issues, but these
are likely to be rectified before release.
Rainswept can be completed in a relatively
brisk six hours or so, and despite the branching
dialogue options, there’s still the feeling that
you’re being funnelled to its conclusion. When
the story’s as rich as this one, however – it runs
the gamut from poignant to gently amusing to
downright unsettling – Rainswept is a mystery
well worth solving.

Rated
Review

HIGHLIGHT
Limping back to the nearest
safe port from an expedition
gone wrong, escaping from
impossible monsters while
your crew turns on you, your
train spews acrid smoke,
and your resources run low.
Life in the Skies is a constant
balance of risk and reward,
making every run unique
and exciting.

 his is the British
T
Empire, but not
as you know it.





 very choice
E
you make can
have massive
consequences.

Review

Sunless Skies
Failbetter’s latest fantasy adventure title really shines

Info

N

obody does game worlds like
the next you’re picking up a Devil desperate for
Failbetter. Fallen London and
escape from the nearest port. It’s like Jules Verne
Sunless Sea are masterclasses in
distilled into a game – a celebration of adventure
making settings that are dense,
in all its weird, wonderful and horrific forms.
detailed and unique without ever
Storytelling aside, the details of commanding
needlessly falling into cliché. The atmospheric,
your train are slightly simplified from Sunless Sea.
gorgeously realised Gothic Victorian adventures
The world is split into multiple regions now, rather
never let up, cementing the studio as a leader
than the singular, massive Unterzee of Sunless
in game narrative. It should be no surprise that
Sea, making managing your resources easier.
Sunless Skies is yet another example of sublime
Permadeath still plays a big role, too, but it’s more
writing in a fascinating setting, but it’s also a
forgiving as some money, items and the map you
streamlined, more approachable title, too.
painstakingly developed over your previous runs
Following London’s escape from deep
are passed down from one ill-fated captain to
underground, Queen Victoria
the next. This helps the game
has defeated the sun and
break free from its starting
“Yet another
achieved immortality,
area a lot quicker, while also
example of sublime
spreading her empire
making a new run feel like
writing in a
throughout the stars. Picking
a continuation of a storied
fascinating setting”
your own backstory, ranging
history and less like just rolling
from academic to street
a new game entirely.
urchin, you are the conductor of a flying train
Sunless Skies makes one stumble in its combat.
in the vast expanse of the skies. Through careful
It’s not diabolical, but the 2D dogfighting is
resource management, you’re tasked with
simple and shallow compared to everything
exploring this bizarre world of clockwork suns
else on offer. Circle around an enemy, let off a
and time fissures, and the more human issues
few shots, occasionally dodge a volley of fire,
of war and labour rights.
rinse and repeat. Gunfights are plodding and,
It’s in these many stories where Sunless Skies
compared to the constant sights and sounds
truly shines. It’s more enjoyable when the combat
of the Skies, terribly mundane.
difficulty and resource usage are turned all the
Regardless, you’d be missing out if you skip
way down to their easiest settings to let you get
Sunless Skies. Its endless enthusiasm in its own
out into the Skies unimpeded. One moment
world is infectious, constantly pushing you
you’re on an expedition into the abandoned
forward to explore the unknown reaches of said
tourist centre in the middle of an artificial star,
world. This is how writing in games should be.

GENRE
Adventure / RPG
FORMAT
Windows (tested)
DEVELOPER
Failbetter Games
PUBLISHER
Failbetter Games
PRICE
£18.99
RELEASE
Out now

REVIEWED BY
Joe Parlock

VERDICT
Sunless Skies will pull you
into its world and never
let you go. This modern
take on the old Choose
Your Own Adventure -style
books is a lesson
in narrative perfection.

83%
wfmag.cc
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Rated
Review

HIGHLIGHT
The character designs are abstract
and just plain bizarre. A main character
whose head has been swapped with
a glowing diamond, enemies that
look like overgrown viruses, and
walls bursting into flocks of birds,
all drenched in neon, are some of
the oddities that give Octahedron its
distinctive visual style.

Review



Octahedron:
 eciphering each level’s
D
rules and quirks is vital.

Transfixed Edition

A mesmerising platform-puzzler hits the Switch

Info

GENRE
Platformer
FORMAT
Switch (tested) /
PC / PS4 / XBO
DEVELOPER
Demimonde
PUBLISHER
Square Enix
PRICE
£9.99
RELEASE
Out now

REVIEWED BY
Joe Parlock

VERDICT

70%
64 / wfmag.cc



Octahedron feels like a
relic from a simpler time,
but in a good way.
The platforming’s slick,
the levels are tough, and
the soundtrack sounds like
a 2003 rave.

M

ore games are being released
right now than ever before.
While that is, on the whole,
a good thing, it also means
plenty of perfectly fine and
fun indie titles are getting buried because they
prioritise nailing the fundamentals instead of
trying to be the next big genre-defining Minecraft
or Kerbal Space Program. That’s why a game like
Octahedron, which feels like something straight
from the indie boom of the early 2010s, is so
refreshing. It’s not going to redefine the world,
but it harkens back to a much simpler time when
the likes of VVVVVV and Braid were all the rage.
Octahedron’s stages are highly vertical, the
obstacles are unforgiving, and being sent all the
way back to the beginning of a stage happens
alarmingly frequently. To help you, you’re given
the ability to generate a limited number of
temporary platforms that move along with you.
This may sound like it makes a game all about
jumping to and from platforms a tad easy, but
the ingenious level design and use of multiple
types of platform, each with their own properties
 iterally everything glows
L
like it’s straight out of Tron.

to master, helps turn it into a devilishly
challenging experience.
Nothing in Octahedron should be taken at
face value. Obstacles react to your presence
and actions, requiring you to use your platforms
as switches, lifts, shields and more. Vital ledges
may fade out of existence as you move on the X
axis, or disappear should you spawn your own
platform in a different place. It’s this requirement
to observe and learn the rules of each level as
you go that gives depth to what would otherwise
be a very by-the-numbers platformer.
Of course, with a core conceit this
uncomplicated, the presentation also needs to
be stellar, and Octahedron has style to spare.
The thumping trance soundtrack and neon
visuals not only make the game an immensely
appealing game to experience, it helps lull you
into a state of flow that’s halfway between Tetrisstyle relaxation and bullet hell hyperfocus. Every
setback and failure blurs into a rush of colours
and sound, with only the transitions between
stages letting you come back up to the surface
for a moment.
Octahedron isn’t a game-changer, but neither
is it trying to be. It isn’t bringing anything new to
the platforming genre, nor is it offering a deep
and emotive story, and that’s completely okay.
What it is offering is fiendishly tricky level design,
a thorough understanding of platforming as a
genre, lush presentation, and a real ‘indie spirit’
that’s rarely been seen since the early days of
Humble Bundle. Calling it ‘essential’ would be
overkill, but there’s a charm to Octahedron that is
absolutely worth checking out.

Now playing
Pole’s Adventure

Saluting the Wii’s
weirdest game
Farewell to the Wii Shop, and its most bizarre title

N

and startle the player at every turn. The staples
ow that the Wii Shop’s gone, it’s
of Super Mario Bros. and Alex Kidd are subverted
easy to forget about how slow
from the first screen: collect a mushroom, and
and awkward it could be, and
you’ll grow to a vast size and immediately die. Try
start thinking nostalgically about
to head down a Mario-like drainpipe, and you’ll
its soothing loading sounds
resurface covered in muck. Collectible fruit will rot
(which we heard a lot of) and perky muzak.
or emerge on the screen half-eaten. Meanwhile,
Nintendo’s decision to shut the Wii’s digital store
a narrator frantically comments on the unfolding
down on 31 January 2019 was an inevitable one,
chaos. If Terry Gilliam made games, they might
given the console’s 13-year vintage. The question
look something like this.
the closure raises, though,
What’s most curious about
is what happens to those
“If Terry Gilliam
Pole’s Big Adventure is its
online-only games that were
made games,
origin: this wasn’t the product
solely available for the system.
they
might look
of a lone bedroom coder’s
The titles we’ve selected in
something like this”
jaundiced mind, but Phantasy
the panel on the right are
Star Universe producer, Takao
just three examples of Wii
exclusives that, to date, have never reappeared
Miyoshi; it was even published by Sega, who
anywhere but the less salubrious corners of the
allowed its distinctive eighties speech sample
internet; unless you already have these games
to play as the game begins. Despite its pedigree,
installed on your Wii, there’s currently no legal
it’s still easy to see why nobody could be
way to download and play them.
bothered to localise Pole’s Big Adventure: the
This is doubly true for an obscure little gem
humour’s too odd, too risqué, and too textcalled Pole’s Big Adventure, a platformer released
heavy to be commercially viable. And now, with
exclusively on the Japanese Wii Shop in February
the global closure of the Wii Shop, this largely
2009. Emerging at a time when developers were
unknown title runs the risk of slipping even
beginning to look again at eighties-era game
further into obscurity.
design (Capcom, for example, had recently put
Nintendo and other companies may jealously
out the retro-themed Mega Man 9), Pole’s Big
guard against the online distribution of their
Adventure reads as a demented parody of Sega
lucrative back catalogues, but currently, console
and Nintendo’s 8-bit output.
games like Pole’s Big Adventure tend to fall
With its pixel graphics, chiptune soundtrack
through the cracks. They’re old, so they cease to
and bare-bones running and jumping action,
be available, and they’re too niche for publishers
Pole’s Big Adventure could’ve come from some
to revive. Barring a legitimate and concerted
low-ranking Japanese developer from the days of
effort to preserve these online-only games,
the NES and Master System; what’s immediately
ageing curios like Pole’s Big Adventure run the risk
apparent, though, is that it’s designed to baffle
of vanishing for good.

Wireframe
Recommends

Alien Crush Returns
WIIWARE
Naxat Soft made some terrific
pinball games in the 1980s and
1990s – among them Alien
Crush, Devil’s Crush and Jaki
Crush – and this belated entry
in the series made decent use
of the Wii’s motion controllers.

Star Soldier R
WIIWARE
Essentially a score attack
mode, vertical blaster Star
Soldier R feels like a proving
ground for a more ambitious
sequel – regrettably, Hudson
Soft never got around to
making one.

Gradius ReBirth
WIIWARE
More a remix than a rebirth,
really, but this late addition in
Konami’s 2D shooter franchise
captures the earlier games’
arcade glory. To date, ReBirth
marks the last proper entry in
the series.
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Killer Feature

Red Faction: Guerrilla

Red Faction: Guerrilla
Give a person a fish, and they’ll eat for the day.
Give them a hammer, and they’ll destroy half of Mars
VOLITION, INC / 2009, 2018 / PS3, XBOX 360, PC, PS4, XBOX ONE

T

here’s always a first time, and even though Red
car into a mobile bomb. The speed at which I took to actually
Faction: Guerrilla was the third game in that
behaving like a guerrilla fighter still bewilders me to this day.
particular series, and plenty of games tackled
Another thing Guerrilla’s destruction did was acknowledge
destruction in one way or another before
hammers in their rightful place. That being: the height of good
Volition’s Mars shooters did, I’m going to stick
comedy. Players completing the game with all sorts of jiggerywith Guerrilla as the first time I truly loved destruction.
pokery would be rewarded with a series of special thwacking
The game itself was decent enough – your standard opentools, culminating in the legendary Ostrich Hammer. Which
world fare, only this open world was a terraformed Mars in the
was exactly what you’d think.
grip of a proletariat uprising, presented with some none-tooIt was this joyful approach to smashing stuff that helped to
subtle Soviet-inspired iconography. It would have been liked,
make Guerrilla’s destructive tendencies so enamouring. It was
not loved, but for one aspect: the destruction.
silly, it encouraged you to muck about, and it was always fun to
OK, so the actual surface of Mars was impervious, as were
see how quickly you could take out a major base of operations
some smaller elements, but generally speaking, in Red Faction:
with a pack of satchel charges.
Guerrilla, if it was made by people, it could
But behind all of the fun was a
be destroyed by people. Naturally these
seriously smart bit of design, in the
“A series of special thwacking
destructive tendencies were harnessed
shape of the Geo-Mod 2 engine (built
tools, culminating in the
for what you’d expect – mission
off the back of John Slagel’s original
legendary Ostrich Hammer”
objectives and side mission/challenges.
Geo-Mod). It’s testament to those
But what was harder to predict was
physics-and-destruction routines that
how much players would take to just smashing stuff up… oh,
even on Guerrilla’s remaster (‘Re-Mars-tered’, as it was officially
who am I kidding? Smashing stuff up is why we live. Guerrilla
called) in 2018, the entire system is still genuinely impressive.
was an exercise in catharsis for dummies; the sort of brain-off
In the decade since Guerrilla’s first release (and even longer
action that satisfies a primal part of the brain. Hit a wall,
since the original Red Faction’s launch) there have been few
it crumbles. Crumble enough wall, the building comes down.
attempts at introducing such levels of delightful destruction.
From there, you’d just get creative. Hitting weak structural
Crackdown 3’s multiplayer does apparently up the ante with
points to see what the minimum amount of damage you could
just how much can be destroyed – I wouldn’t know, I haven’t
inflict on a structure before its implosion, maybe.
played it at the time of writing – and that can only be a good
Or – a personal favourite – riddling a vehicle with stick-on
thing. A ‘blast’, you could say. But the first time (that wasn’t
remote charges and driving it towards an enemy base, before
actually the first time) is always the most special, and Red
diving out at the last second and turning the barrelling MarsFaction: Guerrilla’s destruction really was smashing.
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